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Foreword

Information and Communication Technology (ICT) has influenced our 
life in a great way. ICT has literally made inroads into almost all major 
disciplines across science, social sciences, languages, arts and medicine, 
etc. It has the potential to create newer avenues for employment, help us 
communicate and collaborate better, learn, and understand the nature 
and phenomena as well as improve our skills and standards of living. 
Policymakers across the globe today agree with the potential of ICT in the 
teaching-learning process and recommend ICT to be a part of school and 
teacher education curriculum.

Rapid advancements in Information and Communication Technology 
(ICT) have created unprecedented opportunities in the field of education 
and school education in particular. Mastering ICT skills and utilising 
ICT is of utmost importance for teachers and learners for creating a new 
learning culture.

ICT is stated to have motivational power. It enables students to enjoy 
learning as an active participant, such as by bringing the outside world 
into the classroom or by enhancing one‑to‑one, one-to-many and many-to-
many interaction, among peers, teachers, experts and others. Furthermore, 
ICT has also helped the students in learning new skills, such as searching 
and locating appropriate information, making informed choices, 
learning to recognise the authenticity of sources and collaborating with  
other learners.

Today, we are living in an interconnected world where ICT-based 
applications influence the way we learn, communicate, commute or 
even socialise. Developments in the twenty‑first century skills, such 
as communication, creative and critical thinking, problem solving, 
collaborative learning, etc., are essential at the school level. ICT plays a 
key role in developing these skills.

This book aims to introduce the world of ICT and its applications. It will 
help students to learn, prepare, present and communicate their thoughts, 
ideas and content through various digital formats, i.e., text, image, audio 
and video, etc.

The book will also help students to understand the potential of Internet 
as well as the safety and security issues related to it, and the ways in which 
one can safeguard themselves against malicious activities and incidents 
happening in the cyber world. 
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	 As an organisation committed to systemic reform and continuous 
improvement in the quality of its products, NCERT welcomes comments 
and suggestions from all the stakeholders, which will enable us to revise 
the content of the textbook. 

� Hrushikesh Senapaty

� Director
New Delhi� National Council of Educational 
March, 2018� Research and Training
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Preface

It is well accepted that Information and Communication Technology (ICT) 
has an immense potential to impact learning. Also understanding the 
basics of ICT and mastering the skills is essential and must be regarded 
as a core part of education, along with reading, writing and numeracy. 
The recent efforts of the Government of India (GoI) seeks to deepen the use 
of ICT in almost every sphere of life. The Digital India Campaign (2015) 
strives to transform India into a digitally empowered society and knowledge 
economy by focussing on three vision areas — Digital Infrastructure as Core 
Utility to Every Citizen, e-Governance and Service on Demand and Digital 
Literacy and Empowerment of Citizens. The three cardinal principals of the 
draft New National Education Policy (2016) viz., access, equity and quality 
could be served well by harnessing the huge potential of ICT. The National 
Curriculum Framework (2005) recommends to recognise that given the 
space, time and freedom, children generate new knowledge by engaging 
with the information passed on to them by adults. The curricula for ICT in 
education lays an emphasis on empowering the students in a way so that 
they may get an access to a variety of resources, learn to critically appraise 
information and resources, and make safe, productive, ethical and legal 
use of resources.

The Present Class IX Textbook of ICT takes into account goals of the 
New Education Policy, the recommendations of National Curriculum 
Framework (2005), the Curricula for ICT in Education and visions of Digital 
India Campaign (2015). This textbook is an attempt to foster creativity, 
problem solving and to introduce students to the world of Information 
and Communication Technology (ICT), which may also shape their future 
career pursuits.

The textbook contains eight chapters under four learning strands 
viz. 'Connecting with the World', 'Connecting with Each Other', 'Creating 
with ICT' and 'Interacting with ICT'. It has been carefully designed with 
meticulous efforts of the Textbook Development Team comprising School 
teachers, subject experts, academicians and technical experts from 
government, non-government and private entities. Some of the members 
worked at the advisory level while others contributed towards the actual 
development activity as core team members and members of the textbook 
development committee. It is hoped that the students will appreciate 
the immense potential of ICT and will be encouraged to explore and 
learn further. The textbook writing team has tried to bring a conceptual 
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(vi)

coherence. The pedagogy and the use of easily understandable language 
are at the core of the efforts without sacrificing the technical aspects of  
the subject.

This book has some features which are earnestly expected to enhance 
its usefulness for the students and teachers. The book contains nine 
Quick Response (QR) codes linked to relevant digital resources (text, audio, 
video, and interactive content, etc.). The first QR code is to access the 
complete digital textbook. The subsequent QR codes will help to access the 
relevant digital resources linked to each chapter. There are some questions 
which require critical thinking which would make students think about  
real-time applications of ICT. The textbook also includes a large number 
of examples in order to clarify the concept and to relate these concepts to 
everyday real‑life situations. The inside box in the chapters are introduced 
to highlight the special features of the concepts covered, which require 
additional attention of the students.

Completion this book has only been possible due to the continuous 
support of many professionals and experts. We express our gratitude to 
Director, NCERT, for entrusting us with the task of developing this textbook 
as part of a national effort for improving school education.

The draft received excellent academic inputs from students, experts 
and other practitioners who sincerely suggested improvement during the 
development of this book. We are thankful to all those who provided these 
inputs to CIET, NCERT. We are also thankful to the all the members of 
development and review workshops, language editors and to team DIKSHA 
for rendering technical support for developing QR codes.

We welcome suggestions and comments from our valued users, 
specially students and teachers. We wish our young readers of Class IX 
have an exciting and enjoyable engagement with the world of ICT.

� Amarendra  Behera

� Joint Director
� Central Institute of Educational Technology
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Muskan performed an experiment to find out the weight 
of a solid metallic ball in different media like air, water 
and mustard oil using spring balance. The weight of 
the ball in every medium was noted by Muskan in her 
notebook. The weight was found to be least in water and 
comparatively higher in air than in mustard oil. Muskan 
recorded the entire experiment as a video, explaining 
about the variation of weight in various medium.

Muskan shared this video with her classmates using 
a Messenger App. One of her friends suggested her to 
create a blog to share her experiences. Muskan created 
a blog and regularly shared her learning experiences 
and reflections on this blog. She also uses web tools 
and technology that made her learning experience very 
engaging. Muskan is excited about the potential of 
technology use for learning.

This is only an example to describe how Information and 
Communication Technology (ICT) has started influencing 
the learning experiences. With the world becoming more 
and more digital with time, schools are also progressing in 
their use of ICT. In this chapter you will be introduced to 
the basic ideas of ICT and its uses in the learning process. 

What is ICT?
ICT is the short form of three basic terms — Information, 
Communication and Technology. The representation 

Introduction to
ICT

Chapter
1
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ICT Textbook — Class IX2

of data in a meaningful way is called Information. 
For example, Muskan is a student of Class IX of the 
Government School, Tajpur. She is 14 years old and 
is a Table Tennis player. Her hobbies include singing,  
drawing, reading, dancing, gardening, etc. This is the 
description about Muskan available in her profile at 
school. Based on this information, Muskan's teacher 
selected her to participate in an inter‑school poster 
making competition‑on “Dance forms of India”. 
Thus information (meaningful data) can help in 
decision‑making also.

The term communication may be referred as 
imparting or exchanging of information by  speaking, 
writing, or using some other medium. In other words, 
it may be referred as conveying your feelings, thoughts 
and emotions in any verbal and non-verbal medium. 
Any communication has four essential elements, 
namely ‘sender’, ‘message’, ‘medium’ and ‘receiver’. 
When all four elements are in sync with each other in 
terms of sequence, relevance, appropriateness, etc., 
then communication becomes effective. Analyse the 
elements of communication followed when Muskan 
shared the video of experiment she recorded.

Activity 1 

Identify the information communicated through 
Figure 1.1.
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
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Introduction to ICT 3

Figure 1.1: Coast Scene
Source: https://goo.gl/ZsTCaq

Technology refers to methods, systems and devices, 
which are a result of scientific knowledge, being used 
for practical purposes. For example, Muskan went to 
an excursion to Bhubaneswar and visited the State 
Museum. She saw various mineral ores in the mineral 
section of the museum. She decided to capture 
photographs to share with others who may not have 
seen the ores. She borrowed her teacher’s mobile and 
clicked pictures of the rare collection. She shared all the 
pictures on her blog along with a description of the ores. 
Many viewers commented and appreciated Muskan for 
sharing those pictures and description.

Technology can be used for creation and 
communication of information. The term Information 
and Communication Technology (ICT) includes various 
forms of technologies that are used to create, display, 
store, process, transmit, share or exchange information 
by electronic means (UNESCO 2007). Such a discipline 
which deals in the creation and communication of 
information is called ICT (see Fig.1.2).

Radio, television, and print media (Newspaper, 
Books, Magazines, etc.) are the popular technologies 
used for communication. The digital revolution has 
transformed the way these traditional technologies 
function. For example, analog television has become 
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digital television. In addition to printed newspapers 
now we also have their electronic versions. Along with 
traditional radio, we also have online radio.

Evolution of ICT
We cannot live in isolation. We need to interact and 
communicate with each other and with our surroundings. 
In the ancient times people used smoke signals, 
drum sounds, pigeons and messengers as modes of 
communication. These were relatively slow, unreliable 
and sometimes unsafe means of communication.

With the advent of new technologies, the modes and 
methods of communication are changing very fast. Radio, 
television, computers, telephones, smartphones, digital 
camera, laptop and interactive board have revolutionised 
the ways of communication. These are very fast and can 
link distant locations within no time.

We can easily send messages across the globe and 
learn about events all over the world in a blink of eye. 
Numerous technological tools have come up which help us 
not only to communicate but to create, store and manage 
information. The diverse set of technological tools and 
resources used to store, manage, manipulate, create and 
communicate digital information come under information 
and communication technologies (ICTs). 

Figure 1.2: ICT Around Us
Source: https://goo.gl/vytpr7
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Introduction to ICT 5

Why ICT?
ICT facilitates communication anywhere, anytime 
and by anyone. It has become easier to communicate 
worldwide through the use of ICTs, for example, social 
media sites and apps, blogs, wikispace, etc. The use of 
ICT is time saving and cost effective in various ways.

ICT has revolutionised the world. There was a 
generation that did not have telephone; there was a 
time when radio and television were considered as 
the most advanced sources of information. However 
now the new generation lives in the world of Internet, 
wireless, augmented and virtual space. The world 
around has drastically changed. The dramatic change 
due to ICT has resulted in innovation in every field. 
These innovations have reduced the size of the 
technological tools and increased the speed with 
which they operate to process data and communicate 
information. 

All these advancements and innovations give scope 
for betterment and effectiveness.

Muskan has a cousin Nishi who lives in Bengaluru and 
who is also of her age. She has same hobbies like her, 
such as dancing and gardening. Both of them are very 
fond of each other. They like to talk very often, they 
discuss about new things they do in gardening for hours 
together over phone. But making phone calls frequently 
was very costly and unaffordable for them.
     Hence they always had to restrict their discussions 
on gardening. A friend of Muskan informed her about 
online video calling facility like Skype, Google Meet, etc., 
which  is more cost effective than making, phone calls. 
Muskan installed Skype on her laptop and her cousin 
also installed it on her Smartphone. They are now able to 
discuss on several topics without any restriction.

•	 Access to instant data: Access to instant data 
supports in predictions, decision making and also 
knowledge acquisition.
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Muskan’s family planned to go on a trip to Mount Abu. 
While packing, her mother was a little confused about 
carrying woollen clothes as she was unaware of the 
temperature in Mount Abu. Knowledge about ICT helped 
Muskan to help her mother. She checked the temperature 
in Mount Abu during the past few days from meteorological 
website. As the recorded temperature showed a higher 
temperature for past 15 days, she informed her mother 
to carry more semi woolen clothes. Instant access to data 
helped them to reduce the luggage and have a pleasant 
journey with required preparedness. 

●	 Creation of information for communication: ICTs 
can be used to create communication pieces in various 
forms like text, image, audio, video, multimedia, etc. 
Once the information is in digital form it can be used 
for recreating resources out of the original. Digital 
information is also easy to modify and share.

Muskan’s cousin Nishi visited a historical place ‘Hampi’ in 
Karnataka. When she saw the beauty of the architecture 
she thought of sharing it with Muskan.

Nishi decides to show Muskan the archeological site 
through Skype, but her father suggested her to share it 
through Facebook live so that not only Muskan but her 
other friends can also see her exploration. As the mobile 
had a 4G network, the speed of the Internet supported 
online streaming.

This act of Nishi helped Muskan to have a virtual trip 
to Hampi. She thought for a while and found a solution 
to make a great resource about Hampi that can be 
shared with others. So she downloaded the video shared 
by Nishi. Using a video editor, she edited the unwanted 
content, added a background music and shared it with 
her schoolmates who never saw Hampi. The knowledge of 
ICT helped in capturing the events Muskan herself had 
never seen and sharing them through online streaming.

●	 Store and organise: ICT helps in organising    
information in various forms. This organisation of 
information helps in retrieving the required data.  
For example, in libraries, all the information 
about books are organised as database by using 
management software. If anyone wants to check 
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the availability  of books, it is easy to search in the 
database and find the availability. 

Muskan's grandfather had a great collection of postage 
stamps. He gifted his collection to Muskan on her birthday. 
She was thrilled to get this collection but she observed 
that the collection compiled in an album will perish over 
time. She decides to give the collection a lasting life by 
converting it into a digital collection. She along with 
her brother scanned all the stamps and added tags like 
country to which they belonged, date of release, event, 
personality, phenomenon depicted on the stamp, etc. This 
digital storing and organising helped her to retrieve any 
stamp whenever she require and also to easily maintain the 
record.

●	 Scope for learning: 	ICT provides a great opportunity 
to learn. One can learn anytime, anywhere and at 
his or her own pace. We can also create our own 
personal learning environment. Availability of online 
courses, e-tutorials have opened up avenues for 
continuous and life‑long learning.

Muskan used to visit her grandmother's place for every 
summer vacation, but this summer her parents were busy 
with some work. She could not visit her grandmother. 
She was very sad and did not know what to do during her 
summer vacations. Hasmukh, a friend, suggested her to 
do an online course on Puppetry. He sent her information 
about this free course. When she further searched about 
the course she found it to be a Massive Open Online 
Course (MOOC). As she was not aware of MOOC, she 
searched for information about MOOC and learnt that 
MOOCs are free online courses that can be taken up 
by anyone at anytime from anywhere. Muskan joined 
the course immediately and started learning different 
puppet‑making techniques as well as storytelling using 
puppets. She enjoyed the online course on puppetry and 
planned to do a puppet show in her class as a holiday 
project once the school reopens.

●	 Plan and manage : Use of ICT tools can help in time 
management by scheduling the works across devices 
and using various features like alerts, priorities, 
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highlights, etc. ICT tools can also be used in planning 
and managing the activities.

Muskan often forgets the deadlines of returning books 
issued from the library. To avoid paying fines, she sets 
the dates in her father's mobile using a calendar mobile 
app. Also she schedules her exam dates using a digital 
calendar.

How ICT is Useful?
ICT has wide range of applications for the society but 
the extent of its use depends on the user. ICT has its 
existence in all fields. Some of the fields are shown in 
Fig. 1.3.

Figure 1.3: Applications of ICT

Activity 2 
Discuss with your friends, parents and other people 
in your surroundings about how ICT is essential in 
their daily life. Note down the main points emerged.
___________________________________________________
___________________________________________________
___________________________________________________
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1.	Application of ICT in Everyday Life
ICTs have become a way of life in the present day world. 
We are using various ICTs in our day-to-day life for 
reading e-newspapers, e-magazines and e-books, online 
shopping, paying bills for food, using mobile apps, 
getting online appointments from doctors and so on.

Activity 3 

Write a few observations on the uses of ICT at home.
___________________________________________________
___________________________________________________

2.	Application of ICT in Education
a.	Teaching, Learning and Assessment: ICT 

finds presence and expression in almost all the 
functions of the schools, such as admission, 
time table, classroom instruction, evaluation, 
laboratory management, learning resources 
management, examination and certification. It is 
also being used for office automation. E‑resources 
like websites, e-books, e-newsletters, Open 
Educational Resources (OERs), etc., are used by 
most of the schools.

b.	 Inclusive Education: ICT is used for catering 
to the educational needs of every section of the 
society, including children with special needs. 
Various assistive devices and technologies are 
being developed which play an important role 
in fulfilling the specific needs of these children. 
For example, talking books, talk back feature of 
mobile phones, GPS inbuilt walking sticks, etc., 
are making substantial changes in people's lives.  

3.	 Application of ICT in Art: Creative construction and 
connection are being done in various domains with the 
advent of ICT. Creative composition, compilation and 
communication can be done quickly by compatible 
ICTs. The role of ICT is vital in disseminating various art 
forms popular in one area to another. The appreciation 
of Art and Culture gained popularity through ICT. ICT 
has made it possible to showcase the creative works to 
the larger audience.
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Activity 4 

Write a few observations of ICT use in areas related 
to art and culture.
___________________________________________________
___________________________________________________

4.	Application of ICT in Science and Technology
a.	Health: The use of ICT in surgeries has made them 

less invasive, highly precise and automated. Due 
to this the recovery time has reduced many folds. 
Robotic technology has got a positive impact on 
present medical sciences. Now‑a‑days distance 
is not a constraint for any complicated medical 
intervention to be done jointly by doctors located 
at different places through networking.

b.	 Telecommunication: The field of Information 
Technology has seen a lot of advancement with 
the help of ICT. The satellite communication 
has advanced a lot and reached a number of 
people belonging to different setups. Low‑cost 
smartphones and very cost‑effective services have 
made the availability of these to almost everybody 
in the society. App based services available in 
different areas have made people’s life easy.  

c.	 Agriculture and Natural Resources: Frequent 
and almost accurate weather updates have 
revolutionised the agriculture sector. Early prediction 
of rains or other weather conditions by Metrological 
Department has equipped the farmers in getting 
better yield. The sustainable use of natural 
resources has also become possible due to ICT 
integration; now it is possible to locate the oil wells, 
coal mines, etc., with the help of satellite technology.

Activity 5 

Explore more areas of Science and Technology 
where ICT is applied.
___________________________________________________
___________________________________________________
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5.	Application of ICT in Business Transportation 

ICT is used very effectively in the area of transportation. 
The GPS system is installed in vehicles, to provide 
security and easy navigation to the commuters. 
Airplanes and trains use RADAR systems for their 
control and path finding. Application-based services 
have revolutionised the experience of transport system 
by their users. Online reservations of flights, trains, 
buses and other services have further made our  
lives easier.

a.	Marketing: Online marketing through various 
websites and mobile applications is very popular 
in today’s world. People find them useful and 
hassle free. They are not only cost effective but 
also saves a lot of time and effort of the people. 
The online sales and services have generated a 
new type of employment, which require very less 
investment at the source.

b.	 Tourism: Various online hotel booking systems 
have provided a great experience to the users. 
With the advancement of ICT even checking the 
overall scenario of a place before planning a 
visit has become feasible. Also, online payment 
facilities have simplified the travel experience.

6.	Application of ICT in Administration

a.	Public Safety and Security: Deployment of ICT 
makes it possible for the police departments 
to collect, store and rapidly disseminate the 
information to enhance public safety. ICT can 
also be used for the identification of criminals by 
tracing their digital footprints.

b.	 e-Governance and Public Administration: 
e-Governance is generally understood as the use of 
Information and Communication Technology (ICT) 
at all the level of the Government in order to provide 
services to the citizens, interaction with business 
enterprises and communication and exchange 
of information between different agencies of the 
Government in a speedy, convenient efficient and 
transparent manner.
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Exercises

1.	 Which of the following are ICTs? Give reasons why it is or not 
an ICT.

Items
ICT

Yes/No Reason

Digital camera

Refrigerator

Smart TV

Telephone

DVD player

Computer

Headphone

WIFI

Radio

Hard disk

Activity 6

List your observations of ICT use in areas related to 
e-Governance.
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
___________________________________________________
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Exercises

2.	 Discuss with various professionals like tailor, shopkeeper, 
milkman, doctor, engineer, nurse, etc., in your surroundings 
and write the ways in which each of them use ICT in  
their profession.

Profession Ways of using ICT

3.  My principal wants to make a short movie of this function for 
our school website, I will record the event and edit it using 
______________ video editor. 

	 All the students are willing to present gifts for teachers. They 
selected the gifts from ______________  and ordered them, so 
that they can reach us on time.

Rationalised 2023-24



Tanya and Rishi had gone to a book fair. They had a 
great time there. They wanted to share their experiences 
with others. So, they decided to record their experiences. 
Let us see how Tanya and Rishi recorded their 
experiences. Consider Fig. 2.1 given below and put 

Fig. 2.1: Book Fair

Creating Textual
Communication

Chapter
2
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yourself in place of Tanya and Rishi and think what 
information may be shared with others about the  
book fair.

What information I would like
to share with others?

• How many stalls are there in the book fair?
• Which category of books did we like the most?

• Who were the publishers of those books?

Let us see in Figs. 2.2 and 2.3 how they presented  
their experiences.

Fig. 2.2: Tanya’s Report
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Rishi was amazed to see Tanya’s report. It contained 
text of varied colour, style and size. It also had a picture 
and certain symbols before each category of books. 
Tanya had communicated her ideas and thoughts in an 
organised, systematic, effective and presentable manner 
through her report. Rishi asked Tanya how could she 
communicate her thoughts so effectively?
Tanya: Rishi, you should know that there are digital tools 
which can be used to create effective and digital documents. 

Fig. 2.3: Rishi’s Report
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Rishi also wanted to prepare his report using word 
processor. So, he asked Tanya to help him. After taking 
permission from their teacher, Rishi and Tanya went to 
the computer lab of their school. Tanya opened the text 
editor and asked Rishi to create a new document. Tanya 
explained to him the use of various keys on the keyboard  
(Fig. 2.5) for entering the text.

Fig. 2.5: Keyboard

You can delete the errors and also take multiple copies of 
a digital document. My elder sister helped me to create 
this document using a word processor (LibreOffice 
Writer 5.1.6.2) on a computer (fig. 2.4).

Fig. 2.4: LibreOffice
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Document: Any 
piece of information 
created using a text 
editor is called a
document.
Cursor: A vertical 
blinking line in a text 
editor that indicates 
the place where
anything that is typed 
will appear.

Getting Familiar with a Keyboard
Enter key
•	 Press once to move to next line.

Tab key
•	 Press once to move 5 spaces to the right of the 

cursor.

Insert key
•	 Press once more to replace the old text with the 

currently typed text.
•	 Press once again to activate the insert mode.

Delete key
•	 Deletes the character to the right of the cursor.

Backspace key
•	 Deletes the character to the left of the  

insertion point.

Caps Lock key
•	 Press once to type the alphabets in uppercase.
•	 Press once more to revert and type in lowercase.

Shift key
•	 Press along with the alphabet key to type in 

uppercase if Caps Lock is OFF and in lowercase if 
Caps Lock is ON.

•	 Press along with non-alphabet key to type the special 
character/symbol that is above the main character. 

Tanya: Rishi, let’s open the text editor by double 
clicking on the Writer icon on the desktop. Let us try to 
understand how we can work on the Text Editor. When 
we open text editor, a blank document as shown below  
(Fig 2.6) will appear. Tanya also demonstrated how 
to open a new file in the text editor. Rishi followed 
the steps demonstrated by Tanya for creating a  
new document.

The title bar of the new document contains the name 
of the document and the name of the application 
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(OpenOffice Writer). As Rishi had not given any name 
to his document, ‘Untitled 1’ is displayed on the  
title bar.

Tanya: First fix the setting of the document (Fig. 2.7) so 
that the page size, orientation, margins, and background 
colour can be fixed for the report. 

Rishi: Why do we need to do that?

Tanya: Rishi, you must have noticed that the pages of 
your notebook are of the same size and contain margins 
too. This gives a consistent look to your notebook 
Similarly if you set the margins and size of the document 
in the text editor, it will give a consistent look.  

Rishi: What are the orientation types?

Tanya: If you want your document vertically elongated,  
select ‘Portrait’ orientation, if you want it to be 
horizontally elongated, select ‘Landscape’ orientation.

Fig. 2.6: Creating a New Document
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Rishi: OK, so I will select page size as A4, orientation 
as Portrait and 0.79 inch margin on all four sides of  
the page.

Tanya: Fine! And what about the background colour?

Rishi: My favourite colour is yellow ochre, so I will select 
that as the background for my document.

Rishi was happy to see the outcome of the page setting 
of his document and the coloured background of his 
page. He started typing the text in his report. After 
typing, his report looked as it is shown in Fig 2.8.
Rishi was happy to see the outcome of the page setting of 
his document and the coloured background of his page. 

                    Fig. 2.7: Formatting the Page
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He started typing the text in his report. After typing, his 
report looked as shown in Fig. 2.8.

Fig. 2.8: Rishi’s report
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Activity 1
Create a text document on a topic of your choice. Choose 
A4 as page size and 'portrait' as page orientation. Now 
change the page orientation to 'landscape' and observe 
the change in the document.

Once the report was typed, Tanya suggested him to 
save the document as shown in Fig. 2.9 and then close 
it. It is only when the document is saved by a name, it 
can be opened again for viewing or editing. In fact, while 
creating a document it must be saved at regular intervals 
so that the changes made are permanently saved. To 
close the file click File → Close option. To close the word 
processor (Writer), you may click Close button  on 
the top‑left corner of the screen.

Fig. 2.9: Saving a File
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You can also perform a task using keys from the keyboard. 
These are called Shortcut keys. Some of the shortcut keys 
are listed below:

Opening a new document 		 Ctrl + N
Saving a document			   Ctrl + S
Opening a document		  Ctrl + O

Rishi was excited to see his report on the monitor but 
he wanted coloured text of different sizes in his report 
with a bold and underlined title. Tanya demonstrated 
the tools on the Formatting toolbar as shown in 
Fig. 2.11 that would help Rishi add these features to his 
report. He could choose the font name, size and style of 
his choice. Tanya also showed him some fonts names 
like Times New Roman, Courier New, Arial, Calibri, etc. 
She further mentioned tools to edit the font size and 
style — bold, italic or underlined.

•	 Choose Save As 
option when you 
are saving the file 
for the first time 
or you want to 
give a different  
name to an  
already saved file.

•	 Choose Save 
option when you 
want  to simply 
save the changes 
made in an already 
existing file.

You should always 
save a file with a 
meaningful name. 
This helps you to 
easily identify the file 
when you want to 
open it later.

Rishi saved the file by the name bookFairReportRishi.
odt and then closed it by clicking on the Close button. 
Rishi wanted to learn more from Tanya, so  he opened 
his file again.

  Fig. 2.10: Opening a Document
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Rishi formatted the text in his document by using the 
tools on the formatting toolbar, now he wanted the title 
in the centre of the page and date on the top‑right corner. 
Tanya then introduced Rishi to various alignment tools:

•	 Align left: aligns the text to the left margin of  
the page

•	 Center horizontally: aligns the text to centre of  
the page

•	 Align right: aligns the text to right margin of  
the page

•	 Justified: aligns the text to both left and right 
margin of the page

Rishi felt that his report was looking congested. He 
wanted a little bit more spacing between the lines of 
the paragraph. Tanya then explained that the spacing 
can be set between the lines and also between the 
paragraphs as shown in Fig. 2.12. The former is called 

Fig. 2.11: Formatting text
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line spacing and the latter is called paragraph spacing. 
Demarcating a new paragraph by adding few blank 
spaces in the beginning of the first line of the paragraph 
can also be done. This is called indentation.

Fig. 2.12: Formatting a Paragraph

Rishi was happy to apply all the formatting effects to his 
document. Now his report, in Fig. 2.13 appeared more 
effective as compared to that shown in Fig. 2.8.

Fig 2.13: Rishi’s Page with Formatting Effects
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Activity 2
Using a text editor, write a paragraph on ‘My Favourite 
Festival’ and apply various formatting effects listed below.

Also add a quote 'Festivals' in the beginning of the chapter. 
Mark a tick in front of the features that you were able to 
apply in your document.

•	 Title: Bold and Centre aligned
•	 Important points: Underlined, Bold
•	 Paragraph: Justified
•	 Background and Text: Coloured
•	 Font Style
•	 Indentation and Line Spacing

There were certain red and green wavy lines in 
Rishi’s document. As Rishi asked her about the lines, 
Tanya told him that the red wavy line appears below 
a spelling mistake and the green wavy line appears 
below a grammatical error. Now, Rishi tried to correct 
the mistakes by placing the cursor at the appropriate 
position and retyping them. Tanya explained that 
instead of doing it manually, it can be done by using 
the Spelling and Grammar check feature of the word 
processor as shown in Fig. 2.14.

Fig. 2.14: Spelling and Grammar Check

Shortcut keys

Bold	 Ctrl + B

Italic	 Ctrl + I

Underline  Ctrl + U
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Suddenly, Tanya noticed that the word ‘Pragati Maidan’ 
had a red wavy line below it although it was not a 
spelling mistake. On the other hand, Rishi had typed 
the word ‘fare’ instead of ‘fair’ in his document but it did 
not have a red wavy line below it, as shown in Fig. 2.15.

Tanya again opened the Spelling and Grammar dialog 
box, selected the words ‘Pragati Maidan’ and clicked 
Add to Dictionary button. Since the words were now 
added to the dictionary of the text editor, the red wavy 
line no longer appeared below these words. 

To delete the word ‘Fare’ and type ‘Fair’, Rishi placed his 
cursor before the word ’Fare’. He had to repeat this 
process for all occurrences of the word ‘Fare’. This is 
how he learned to use the Find and Replace feature of 
the text editor, as shown in Fig. 2.16.

Fig. 2.16: Find and Replace

Fig. 2.15: Errors in Rishi’s Report
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Rishi wanted to change the position of the quote by 
Stephen Hawking. One method is to delete it from its 
present position and retype at the new position. The 
better way is to use the cut and paste commands, 
through which the text will be removed from the original 
position and pasted to the new position. If you want the 
text to be duplicated and pasted at the new position, 
then choose the Copy command instead of Cut command 
(Refer Fig. 2.17).

Fig. 2.17: Cut, Copy and Paste

Shortcut keys
Cut	 Ctrl + X
Copy	 Ctrl + C
Paste	 Ctrl + V	
Spelling & Grammar	
F7
Find & Replace		
Ctrl + H

Activity 3
Open the file that you created in Activity 2. Copy the quote 
and Paste it at the end of the document. Thereafter do it 
by Cut and Paste. What difference did you notice between 
Cut and Copy options?
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In Tanya’s report, Rishi had also seen certain symbols 
preceding the names of the genres of books. When 
Rishi asked her, Tanya explained that such a list can 
be created using the Bullets and Numbering feature 
of the text editor as shown in Fig. 2.18.  Using Bullets 
feature, the list is preceded by certain symbols. For list 
items, shown by bullets ordering is  not important, on 
the other hand, Number and Alphabets feature can be 
used when there is some order in the list.
Rishi used bullets as shown in Fig. 2.19 to list the 
different categories of bookshe had seen in the book fair.                  

Fig. 2.18: Creating a Bulleted List

Fig. 2.19: Rishi’s List with Bullets
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Activity 4
Tick the appropriate options given in the bracket and 
create at least one bulleted and one numbered list using 
a word processor.
•	 List of fruits you like (Bullets/Numbering)
•	 List of fruits you like in order of preference (Bullets/

Numbering)
•	 Steps to make a cup of tea (Bullets/Numbering)
•	 List of your favourite games (Bullets/Numbering)

During his visit to the book fair, Rishi had made a list 
of his favourite books and CDs in his diary. He wanted 
to create a table depicting Serial Number of the listed 
books and CDs, Title of the book and CD and Name of 
the Publisher. Tanya explained the table feature to help 
him complete the task. He inserted a table (as shown in 
Fig. 2.20) with three rows and four columns. Tanya also 
explained him how to insert more rows and columns in 
the table. He inserted two more rows at the bottom of 
the table (as shown in Fig. 2.21), since he needed to add 
5 names.

Fig. 2.20: Inserting a table
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Rishi successfully inserted the table in his document. 
He also wanted to add a border to his table, so Tanya 
showed him how to format the table to add borders 
(Refer Fig. 2.22).

Fig. 2.22: Borders tab

Fig 2.21: Inserting Rows in a Table
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S. 
No. Title of Book/CD Category (Book/CD) Name of the 

Publisher

1. Science – Vigyan Textbooks NCERT

2. Urdu – Gulzar-e-Urdu Textbooks NCERT

3. Mathematics for Grade 6 Textbooks NCERT

4. Mind Map Your Brain Audio /Video CDs -------

5. Encyclopedia Audio /Video CDs Britannica

6. What on earth is energy? Children’s Book NCERT

7. Indian Education Journals NCERT

8. Barkha – A Reading Series for All Miscellaneous NCERT

Fig 2.23: Table Inserted by Rishi

Rishi was able to apply green borders to his table. He  
also gave headings to his table by using Bold tool on the 
formatting toolbar. That is how Rishi's table looks (Refer 
Fig. 2.23).

He observed that the category 
'Textbooks' was repeating in 
three rows. He wanted the word 
‘Textbooks’ to appear in such 
a manner that it represents all 
the books under this category. 
Similarly, he wanted 'Audio 
and Video CDs' to represent 
both type of CDs. This could 
be done using Merge feature 
of the text editor, as shown in  
Figs. 2.24 and 2.25.

Fig. 2.24 : Merging Cells of a Table
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S. No. Title of Book/CD Category (Book/CD) Name of the 
Publisher

1. Science – Vigyan

Textbooks

NCERT

2. Urdu – Gulzar-e-Urdu NCERT

3. Mathematics for Grade 6 NCERT

4. Mind Map Your Brain
Audio /Video CDs

-------

5. Encyclopedia Britannica

6. What on earth is energy? Children’s Book NCERT

7. Indian Education Journals NCERT

8. Barkha – A Reading Series for All Miscellaneous NCERT

Fig. 2.25: Table with Merged Cells

Rishi had a very good photograph of book fair saved on 
the desktop. He wanted to insert that photograph in his 
report. Tanya helped Rishi to insert the photograph in 
his report (Refer Fig. 2.26).

Fig. 2.26: Inserting a Picture
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To further enhance the report, Tanya demonstrated 
how to insert headers and footers in the document as 
shown in Fig. 2.27. A header contains the text that will 
be displayed on the top of each page of the document 
while the text in footer will be displayed at the bottom of 
each page of the document. Rishi wanted to insert the 
text ‘Rishi’s Report' as the header and page number as 
the footer.

Tanya explains him how to insert Header and Footer to 
document (Refer Fig. 2.28).

Fig. 2.27: Inserting a Header

Fig. 2.28: Inserting Page Number

Take any textbook
of Class IX and observe

 what has been placed as
header and footer on the
pages of that textbook.
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Keep saving your 
document at 
regular intervals.

Activity 5
In the document created in Activity 2, do the following:
•	 Insert the list of food items prepared during the festival
•	 Insert the 'Favourite Festival' in the header and page 

number in the footer
•	 Add a table describing atleast five activities that 

happens during festivals
Tick mark the features you have added to your document.
•	 Bulleted list/numbered list 
•	 Tables with headings
•	 Merge rows/columns 
•	 Header and footer
•	 Picture/photograph
Answer the following questions based on the above 
activity.
•	 In which menu option did you find the table option? 
•	 Have you inserted a bullet list or a number list? 
•	 How many rows and columns does your table have?
•	 What did you insert as a footer in your document?

Rishi was very happy to see his document now. He 
wanted to show it to his teacher and parents. So, he 
decided to take two printouts. Before giving the print 
command, Tanya clicked the File→Print Preview button 

Fig. 2.29: Print Preview
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to show Rishi how the document would appear on paper.
By doing so both the pages of Rishi's report were 
displayed as shown in Fig. 2.29. Tanya told him how to 
set the number of pages that he wanted to see while 
previewing the document. Since Rishi was happy with 
his final report, he clicked Close Preview button to close 
the preview. Tanya again reminded him to save the 
document and Rishi clicked the Save command. Now it 
was time to print Rishi’s report. He switched on the 
printer and made sure that the printer was connected 
to the computer. Then he opened the Print dialog box 
and selected ‘2’ for the number of copies of the document 
to be printed as shown in Fig. 2.30.

Fig. 2.30: Printing a document

Next day, Rishi and Tanya opened the document to 
show it to their friends in the computer lab of their 
school. On opening the file, they were surprised to see 
that the document was not the same one that they had 
saved a day before. Some student might have altered 
the report. Their teacher explained that their document 
had been saved in an editable format, so it could be 
modified or edited by anybody. If they wanted that their 
document should not be edited or modified in any 
manner, then they should convert and save their file in 
a non-editable format. One such format is a Portable 
Document Format (pdf). Once a document is saved in 

Take a print out only 
if it is required. Avoid 
wasting paper and 
contribute your bit 
towards saving trees.

If the report is in 
digital form, either 
saved in some storage 
device or seen  on the 
monitor, it is called a 
soft copy.

The report that is 
printed on the paper 
is called a hard copy.

It is not ethical to 
see or edit other 
people's documents 
and material without 
seeking permission.
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this format (as shown in Fig. 2.31), it becomes 
non‑editable. Their teacher then explained how to 
convert the final document into pdf format.

Fig. 2.31: Converting to PDF Format

Exercises

Tanya and Rishi were delighted to show the report 
to their friends. They had learned to use the various 
features of a text editor. Their teacher was also very 
proud of them and encouraged other students to learn 
how to use a text editor. This will help them to create 
their own digital document.

Do it Yourself
1.	 Identify whether the following statements are True or 

False
a.	 Spelling and Grammar check is a part of text editor.
b.	 Bullet listing and numbering can be done using 

Format option in a text editor.

Chapter 2.indd   37 7/22/2020   12:35:16 PM

Rationalised 2023-24



ICT Textbook — Class IX38

c.	 Copy feature is used to make copies of a picture.
d.	 Before taking a printout, check if its Print Preview is 

favourable.
2.	 In your school, Independence Day was celebrated. 

Prepare a detailed digital report using a text editor so 
that it could be printed in the school magazine.

3.	 Using a text editor, create a document to express your 
thoughts on your favourite movie.

4.	 You got a chance to view a cricket match in the stadium. 
Create a document to share the experiences with your 
friends.

5.	 The Red Cross Society is organising a Cleanliness Drive 
in your locality. Create a document to summarise the 
welfare activities performed by them during that period.

6.	 Collect the family details (5–6 families) of the people 
living in your locality and present that information in a 
tabular form. Format the table  and check, if some rows 
or columns can be merged to simplify the table. After 
creating the document, save it and submit the printout 
to your teacher.
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Samayra and Shirom visited a fair organised in a 
village and wanted to write and send an article in a 
newspaper consisting of a writeup and a collage. They 
were very happy as Samayra was fond of photography 
and Shirom was good at writing articles. Samayra took 
pictures throughout the day and in the evening they 
both sat down to check those pictures. When they saw 

Fig 3.1 : Village mela

Chapter 
2

Chapter 
1 Creating Visual

Communication
Chapter

3
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the pictures they were not happy as the pictures were a 
little dull and not focussed properly.

Shirom: Samayra, don't get upset I am familiar with a 
graphics editor software  which will help us in modifying 
and enhancing these images. 

Samayra: Shirom, do you know editing can also be done 
with a smartphone.

Shirom: Yes Samayra, you are absolutely correct, but 
I know a Free and Open Source Graphics Editing Tool 
which can help us to enhance images we have.

Check Yourself
What needs to be checked for selecting a picture for an 
article?

(a)  Clarity of picture
(b)  Information in the picture
(c)  Size of the picture
(d)  Any other ______

Shirom: Samayra, now tell me what modifications you 
want in these images. I will demonstrate how we can use 
various features of the graphics editor for modifications 
in these images.

Shirom: Let's first open the image we want to modify. 
(Refer Fig. 3.2).

Fig 3.2: Opening an image

Canvas is the area 
where you insert and 
modify an image. A 
canvas can have
many layers.  A layer 
comprises one
image. The New
option of File menu 
also opens a new 
canvas where we can 
mention the size of the 
image. The size of an 
image is measured in 
pixels. A pixel is the
smallest illuminated 
area on a screen.

GIMP is a multimedia 
tool suitable for a
variety of image
manipulation tasks,
such as  photo editing, 
collage creation and 
free from drawing. 
GIMP stores an image 
in  .xcf format.
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Samayra: Shirom, see this image. It contains some 
unwanted areas which I don't want. Refer Fig. 3.3.

Shirom: Don't worry Samayra let me tell you how you 
can remove the unwanted area of the picture. This is 
known as cropping as shown in Fig. 3.4.

Fig. 3.3: Image showing unwanted area

Fig. 3.4: Cropping an image
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Samayra: Yes Shirom, this is exactly what I wanted.

Moving the mouse pointer over the tool in the toolbox, 
as shown in Fig. 3.5 and letting it rest for a moment, 
usually displays a ‘tooltip’ that describes its usage. 
Short cut keys are also frequently shown in the tooltip. 
In many cases, you can hover the mouse over an item 
and press the F1 key to get help about the tool that is 
underneath the mouse.
Shirom: Samayra, let me now tell you how to create a 
copy of an image. For this we will have to create a new 
layer. Refer Fig. 3.6 to add, a new layer.

    Fig. 3.5 : Tool Box

A Toolbox is an area 
which contains tools 
to perform basic 
tasks. Tools can be 
added or removed as 
per our requirements. 
The toolbox is placed 
by default on the 
left side when you 
open GIMP interface.
One can also select the 
portion to be cropped 
by using Tools
Selection Tools     
Rectangle Select.
Select and then select 
Image  Crop to 
Selection to crop an 
image.
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Paste the copied image to new layer using Edit → Paste 
as → New Layer.

A new layer with the image is created on top of the 
previous layer. Click on the image and using the Move 
Tool to move the image to right side of the existing image.

Fig. 3.7 : Copied image

  Fig. 3.6 : Layering an Image
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Samayra: Shirom, I was thinking of creating a replica of 
this image but in the opposite direction.

Shirom: Oh, that's known as flipping an image.

To do that we first need a copy of the image you want to 
flip. Refer Fig. 3.8 to flip an image.

Before flipping
should a copy of

the image be kept?

Fig. 3.8: Flipping an image

Fig. 3.9: Flipped image
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Shirom: Samayra, just like flipping we can also rotate 
an image. Refer Fig. 3.10 to rotate an image. 

Fig. 3.10: Rotating an image

Check Yourself
Download an image of a flower.

1. Create a copy of this image.
2. Use the shortcut key to crop certain areas of this 

image 
    which you think are not required.
3. Flip the cropped image vertically.
4. Rotate the flipped image by 90 degrees.

Shirom: Another important aspect is to reduce the 
size of an image so that it can be mailed or  used for 
any other purpose. The solution for this is to scale the 
image. Scaling down is the process of reducing the size 
of an image. This will change the number of pixels it 
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contains and resize the canvas accordingly. An image 
can be scaled in two ways. 

a) 	Using Tools → Transform Tools. Refer Fig. 3.11(a) 
b)	 Using Image → Scale Image. Refer Fig. 3.11(b)

Fig. 3.11(a): Scaling an image using Tools menu

Fig. 3.11(b): Scaling an image using Image menu
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Shirom: So, now another important feature of GIMP is 
the brightness control tool which helps us in enhancing 
an image. Let me tell you about how to use this feature 
to make dull images bright. Refer Fig 3.12 to brighten  
an image.

DPI stands for Dots 
Per Inch which 
technically means 
Printer resolution. 
Today, it is a term 
often misused, 
usually to mean 
PPI, which stands 
for Pixels per Inch 
which is the display 
resolution. Higher 
the resolution better 
the printing quality.

Fig. 3.12: Brightening an image

Shirom: Samayra, let me now tell you another very 
interesting feature with the help of which I will create 
the reflection of an image.

Samayra: Oh that's great! Shirom, this will further help 
us to enhance our images.

Samayra: Shirom, I want you to reflect the given image  
(Refer Fig. 3.13).

Chapter 3.indd   47 27-Feb-19   4:42:07 PM

Rationalised 2023-24



ICT Textbook — Class IX48

Shirom: Samayra, now I will describe the steps to reflect 
an image.

1. 	Create a new file (1080 × 760) with a transparent 
background. The transparent background can 
be given by choosing Transparency option in Fill 
with from Advanced Options while creating a new 
image. Refer Fig. 3.14.

2.	 Copy the image you want to reflect and drag it on 
top with the Move Tool and Scale to its half of the 
image canvas size in Height.

3.	 Duplicate the layer by right clicking on the layer 
of the image then choose — Duplicate Layer.

4.	 Flip vertically the copied image, using the Flip 
Tool. The duplicate layer with flipped image is 
added on top of the existing  layer.

5.	 Drag the new flipped image just below the original 
image. (Refer Fig. 3.15).

Layer palette displays 
all the layers in the
canvas and can be made 
visible by choosing 
Windows -> Dockable 
Dialogs -> Layers.

Fig. 3.13: Image to be reflected
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6.	 Right click on the new layer in the Layer palette 
and click on Add Layer Mask and choose White 
(for full opacity). Click on Add. (Refer Fig. 3.16).

7.	 Add a gradient with the Blend Tool and to be more 
precise, click on Ctrl key while using this.

8.	 In the Layer Window set the opacity of the new 
layer to 65% and right click on the layer to Merge 
it down (Refer Fig. 3.17).

9.	 Click on the vertical rule and drag mouse and add 
a perspective by choosing the Perspective tool.

Fig. 3.15: Flipped layer of an imageFig. 3.14 Creating an image with transparency

Fig. 3.16: Layer palette Fig. 3.17: Merging down a layer from layer palette
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Samayra: The reflected image looks so beautiful (Refer 
Fig. 3.18).

Shirom: Samayra, now I will tell you how to add text 
with effects as an image.

For adding text as an image follow the given steps:
1.	 Create a new image of appropriate size (256 x 128 

for the logo/caption/heading/title.
2.	 Set the Background colour of the canvas to black 

by changing the RGB values to (0,0,0).

Fig. 3.18: Reflected image
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3.	 After setting the RGB values choose the Bucket 
Fill Tool,  to fill colour in the canvas.

4.	 Now choose the Text tool from the toolbox.
5.	 Next step is to change the foreground to white 

RGB (255, 255, 255) as on black canvas white 
coloured text will be visible clearly.

6.	 After setting the text boundary type in the 
required text. “A VILLAGE MELA”. The text will 
be added as a new layer (Refer Fig. 3.19). The 
Layer palette will have two layers now. The newly 
added text layer and the background layer.

7.	 Now right click on the new canvas with text and 
choose New from Visible option. This again adds 
a third layer with the name “Visible” in the layer 
palette (Refer Fig. 3.20).

8.	 Give effects to text as per your requirement by 
choosing Filter→Blur. Here we are invoking the 
Gaussian Blur.

9.	 Now, I am going to add a new layer with 
plasma effect. To add plasma effect choose 
Filter → Render → Clouds Plasma effect. (Refer 
Fig. 3.21).

10.	 The next step is to generate a fake 3D shape 
on this plasma layer. The process is known as 
‘bump mapping’. To do this select Filter → Map →  
Bump Map.

11.	 Now, I will isolate our bump mapped text. For 
the same add a Layered Mask with White (Full 
Opacity) to the plasma layer:	Layer → Mask → 
Add Layer Mask. (alternatively Right‑Click on the 
plasma layer and choose “Add Layer Mask…”).

12.	 Now, copy the ‘Visible’ layer and paste it into the 
layer mask for the plasma layer.

13.	 Make plasma layer active by Left-Clicking on it 
and Paste the “Visible” layer on it. Edit→Paste. 
This will now insert a Floating Selection (Pasted 
Layer) into your image.

14.	 The next step is to get this Floating Selection into 
the mask so we need to Anchor it by choosing 
Layer → Anchor Layer.
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Fig. 3.19: Text as an image

Fig. 3.22: Text as an image

Fig. 3.20: Layer palette with three layers

Fig. 3.21: Layer with plasma effect

Finally, save the file by clicking 
on the File Menu → Save As and 
then give the name of the file (for 
example, Myfair1). The final image 
can be seen in Fig. 3.22. By default 
the image is saved in .XCF Format. 
Close the image file once you finish 
working on it by clicking on File 
Menu → Close View or Close All.
Samayra: Shirom, I don't like the 
red color of the text on the board of 
the given image. (Refer Fig. 3.23).

How to remove the
text and merge it

with the background?

Fig. 3.23: Image with unwanted

Shirom: No problem Samayra. GIMP 
has a feature with which you can 
remove patches and merge it with the 
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The default  file format 
of GIMP is .xcf. These 
files are heavy and have  
low resolution. There 
are various other file
formats into which these 
.xcf files can be exported.
JPEG: Accepted
worldwide good quality 
compressed format.
PNG: Good quality bulky 
format which is
supported by all 
browsers.
TIFF: Bulky but good 
quality format
supported by all image 
processing software.
It is a good practice to 
modify your .xcf files 
and export it to a format 
like JPEG.
By clicking on File →  
Export, the ‘Export 
image JPEG’ window 
will open. Here the 
quality of the image can 
be changed.

background. The Clone tool is used to copy from an 
image or a pattern by using the current brush. It helps 
in repairing images having problem areas by ‘painting 
over’ them with pixel data from other areas. This works 
just like the ‘Format Painter tool’ of a text editor.

Follow the given steps to use the clone tool.

1.	 Insert the image which requires correction.
2.	 Select the Tools  Paint Tools  Clone or By 

clicking on the tool icon  in Toolbox. Adjust the 
opacity if it is less than 100, to make it look more 
natural. Adjust the scale and the brush size 
depending on what you are covering.

3. Hold down the Ctrl key on the keyboard while 
dragging the mouse. If required change the size 
the clone brush by moving the scale button. If 
Alignment is set to None, Aligned, or Fixed in tool 
options, then the point you click on becomes the 
origin for cloning. The image data at that point 
will be used when you first begin painting with the 
Clone tool. In source‑selection mode, the cursor 
changes to a reticle cross symbol. 

4.	 You can click on as many areas as you want to 
clone. The Ctrl key is used to select the source, if 
you are cloning from an image.

Refer Fig. 3.24 for the final image without text.

Fig. 3.24 Image without unwanted text
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Samayra: Now, how do we club all these images together 
in one canvas?

Shirom: That's not a difficult task Samayra. Let me show 
you how to do that. Refer Fig. 3.25 to club all images 
together to create a collage.

Fig. 3.25(a): Creating a collage
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Exercises

1.	 Fill in the blanks
a.	 GIMP is an acronym for _________ Image _____________ 

Program.
b.	 An image has some unwanted portion which should be 

removed by ______________ tools.
c.	 Crop tool is found under ________________ Menu.

2.	 Identify whether the following statements are True  
	 or False
a.	 Flip/Rotate tool is part of selection tool. (T/F).
b.	 Flip tool can flip at any angle. (T/F).
c.	 GIMP has a brightness control tool which helps in 

enhancing an image. (T/F)
d.	 Scaling down is the process of reducing the size of an 

image. (T/F)

Do it yourself

1.	 You have taken a photograph in low light and it appears 
dull. Using different tools in GIMP, convert this dull 
photograph into a brighter one.

Fig. 3.25(b): Creating a collage

7. Similarly you can add more images through open as layer in the canvas. 
8. Click on the layer to resize and move the image under layer panel. Resize 

and place the image using scale tool and move tool. Select the layer of 
Picture you want to work on. Now right click on the layer that has your 
picture, choose “scale layer”, resize the image to fit in the grid.
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2.	 You have a photograph with your friends along with 
some unknown person in one corner of the photograph. 
Make an image that has only your friends and submit it 
to your teacher. 

3.	 You celebrated a festival at home. Make a collage to 
show different scenes from the celebration.

4.	 You have an old photograph without any caption. Write 
a proper caption on the photograph. 

Test yourself

1.	 While using the crop tool which area of the image is 
cropped? Darkened area or remaining area.

2.	 Brightness control tool is used for what purpose in 
GIMP?

3.	 For what purpose is an image scaled in GIMP? 
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In the last chapter, we learnt how to create still images 
and enhance them, now it will be interesting to see how 
to create audio and video resources.

The use of more than one medium of expression or 
communication is called multimedia. Multimedia uses 
a combination of text, audio, images, animation, videos 
and interactives. This is different from traditional forms 
of printed or hand produced material.

Content means something that can be expressed 
through some media like speech, writing or any other 
form of art.

Students in a class are discussing about the activity 
they have performed on purification of water.

Neer: Why is this activity necessary?

Nancy: What is the use of this activity?

Raima joins the school after a long gap. She is surrounded 
by her friends, everyone is curious to know the reason 
for her long absence from the school.

Neer: Raima, you were always very regular in attending 
school, why were you absent for a week?

Raima: I was suffering from diarrhoea and fever.

Nancy: Oh! What did the doctor say?

Interactives 
mean a two-way 
communication 
where the user 
interacts with the 
content and gets 
feedback.

List of waterborne 
diseases 
•	 Diarrhoea
•	 Dysentery
•	 Typhoid Fever
•	 Cholera
•	 Hepatitis A
•	 Jaundice etc

Creating Audio 
Video CommunicationChapter

4
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Raima: The doctor said it was due to drinking 
contaminated water. The doctor also told me that 
many people are dying because of water pollution and 
waterborne diseases every year. 

Neer: Oh, it is a very serious issue. 

Nancy: You know Raima, yesterday only, we did an 
activity on water purification.

Raima: Oh! It is good that you performed such a relevant 
activity. Can you explain me what you learnt.

Neer and Nancy explained all the activities they 
performed yesterday.

Raima: Had I performed the activity myself, I would 
have learnt better by performing the activity. 

Neer: Let us do something, so that you may not miss 
out the learning.

Nancy: Specially this water purification activity is very 
useful for everyone.

Neer: We can create posters to generate awareness on 
the importance of water purification.

Raima: Let us make something which can be more 
impactful and interesting than a printed material.

Activity 1
Imagine yourself as a part of this activity, what media will 
you use to explain this?

Nancy: Can we record an audio?

Raima: It is similar to what you explained to me but I 
did not understand it. I think we need to demonstrate 
the process.

Neer: So, you want us to do the activity all over again. 

Raima: Yes, and this time we will record it. We will also 
add posters, text, images, audios and may be some 
more materials and create a small video film.

Nancy: Yes, it will help us understand the concept better 
and we can also share it with others.

Neer: What all do we need to do for making this video film?
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Raima: We already have a topic, the title of our video 
film will be ‘Waterborne diseases and their prevention.’

Activity 2
Think about what content should be included to make a 
video film on Water Pollution.

Nancy: So we need to have information on water pollution, 
causes of water pollution, effects of water pollution, 
waterborne diseases and methods of purification of 
contaminated water.

Raima: So first of all, we had to collect all relevant 
information to make this video film, we also need to 
know sources of information.

Neer: We can use books in the library to collect 
information about Water Pollution and its effects and 
present it through images and audio narration. 

Nancy: We can talk to a doctor to learn more about 
waterborne diseases and then present it through text 
and audio narration. 

Raima: We will request our science teachers to help us 
in identifying more activities for water purification. We 
will record a video of water purifying techniques.

Nancy: So now we have to decide who will do what.

Raima: I can go to the doctor and collect more information 
on waterborne diseases.

Neer and Nancy: Raima can learn more water purifying 
techniques form the science teacher then we will record 
a video on the techniques of purifying water.

Nancy: I can search information from the library. 

The students have collected all the information in the 
form of text and images. They have also recorded a video 
showing the techniques of water purification.

Neer: Now we have to write the audio script based on 
the information we have collected from various sources. 

Raima: But how are we going to record an audio?

Neer: Let's record it in the evening through my mom's smartphone.
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In the evening, they all gathered at Neer's house to record 
the narration. But while playing back they noticed some 
disturbance in the audio. 

Nancy: How to remove this disturbance from the audio? 

Raima: We can use software to edit the audio narration. 
So, let’s first get familiar with the Audacity interface. 
(Refer Fig. 4.1).

Fig. 4.1 : Audacity Interface

Let’s begin with Audacity and Record Narration.

1. Go to file and click “New”. A new window will appear 
(Refer Fig. 4.2).

Raima: Let us start creating our audio resource.

Fig. 4.2 : Getting started

How to record an 
audio?
There are two types 
of recording devices: 
analog and digital. 
It has its own merits 
and demerits and 
they may be used as 
per need of the task. 

List of recording 
devices
•	 Mini Disc 

Recorder
•	 DAT Recorder
•	 Desktop and 

headphone
•	 Laptop Audio 

Interface
•	 Smartphone

List of audio tools
•	 Audacity
•	 Mixxx
•	 Ardour

Audacity
•	 Audacity is a free 

open source digital 
audio   editor to 
record computer  
software 
application, 
available for 
Windows, macOS/
OS X, Linux and 
other operating      
systems.

•	 Interestingly, you 
do not need sound 
mixer or any other 
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sophisticated 
device to use it.

Using Audacity you 
can
1. 	record by default 

microphone 
or by external 
microphone.

2. 	edit, import and 
export audio files.

3. 	mix tracks by 
using envelop.

4. 	create effects and 
even increase 
amplitude.

5.	 use multiple 
tracks.

Raima: Let us add a new track (Refer Fig. 4.3).

Fig. 4.3 : Adding a new track
A new track will appear in which you can record your 
voice or sound using either default microphone or the 
external microphone. Ensure that proper silence is 
maintained while recording. To start the recording click 
on the Red recording button (Fig. 4.4) and speak. To 
finish recording, press the Stop button or the Space Bar 
on your computer. You can insert more tracks in a 
similar fashion.

Fig 4.4 : Recording an audio
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Nancy: While recording, you have coughed a couple of 
times. How can it be removed?
Raima: After recording, editing can be done to remove 
unwanted sounds, such as fumble, repeated sentences, 
coughing, pops, etc. Using the selection tool we can 
select the portions to be deleted, as shown in Fig. 4.5. 

Neer: Can we add music and sound effects?

Raima: Add a new Track to put Music or Sound effects. 
Make sure that you already have the required music 
file on your computer. Click on the File in the menu 
bar and choose the Import option. After clicking on the 
Import option, browse and select the audio file. 

It will be imported on the new track.

Neer: How do we mix these tracks?

Raima: You can mix tracks using the Tracks 
Menu option.

Once selected, press Delete on your keyboard or delete using the Edit menu.

Fig. 4.5 Editing the track
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The software will mix your narration and other sound 
tracks effects, as shown in Fig. 4.6.

Raima: Before going further, lets save our file. The final 
track can be saved in the default .aup format (Audacity 
Project) which is an editable format. 

Nancy: Is it possible to add this track in my presentation?

Raima: For this you have to convert it into a suitable format 
like .mp3 or .ogg using the Export option. Refer Fig. 4.7.

Fig. 4.7 Exporting the audio

Fig. 4.6 Mixing of tracks
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Fig. 4.9 (A) Importing files (Method 1)

Nancy and Neer: Now we have learnt the creation and 
editing of audio file. Let’s now learn about the Video 
editing tool.

Raima: I know an editing tool OpenShot video editor for 
editing videos, as shown in Fig. 4.8.

Nancy: Let’s try and edit the video showing the techniques 
of water purification that we have recorded earlier.

Types of Video 
editing software
•	 Openshot video 

Editor
•	 Blender
•	 DScaler
•	 Pitivi shortcut
•	 Videolan movie 

creator
•	 Video Editor
•	 Avidemux, etc.

Neer: I am sure the first 
step is to compile all the 
information and organise 
the video files and record 
audio narration in a folder.

Raima: You are very right 
Neer. Once, you complete 
organizing the information, 
you need to import all 
images and video files to 
the openshot video editor, 
as shown in Fig. 4.9(A) & 
Fig. 4.9(B).

Fig. 4.8 Openshot Interface
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Raima: Interestingly, there are two ways to 
add images on the timeline. One of them is 
to drag the three pictures one after the 
other to “Track 2”, as shown in Fig. 4.10. 
Remember that it is possible to change the 
sequence in which these images will appear 
in the slide show by dragging and 
re‑arranging them in the timeline.

               Fig. 4.10: Adding images on the timeline (Method 1)

Raima: The other way is to select one image at a time by 
using the Add to Timeline option, as shown in Fig. 
4.11(A) and Fig. 4.11(B).

Fig 4.11 (A) : Adding images on the timeline (Method 2)

Image and audio files 
can also be imported 
using the shortcut 
key “Ctrl+F”.

Fig 4.9 (B) : Importing files (Method 2)
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Neer : Can we add some background music to the 
slideshow to make it more interesting?

Raima: Yes, you can easily add an audio file by  dragging 
it from “Project File” window and dropping it in “Track 
1” of the timeline, as shown in Fig. 4.2.

          Fig. 4.12: Adding sound to the timeline

         Fig. 4.11 (B): Adding images on the timeline (Method 2)
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Nancy: Does this “♫” mean that an audio has been 
added on Track 1? 

Raima: Good observation Nancy.

Nancy: Can I now preview the project?

Raima: Yes. You can do that by 
clicking on the “Play” button in the 
preview window. Refer Fig. 4.13.  
Remember, if you need to re-arrange 
any clips, just drag and drop the 
clips to move them.
Neer: Can I use this video in my 
presentation? 

Raima: First let’s save this video in 
the default .osp format (as shown in 
Fig. 4.14) which will allow us to edit 
it later.  But to use this video in our 
presentation, we will have to export 
it in a suitable format like .mp4 or 
.ogg., as shown in Fig. 4.15.

Fig. 4.13: Project Preview

Fig. 4.14: Save the project

Click on the save Icon 
in the toolbar or use 
shortcut key Ctrl+S 
to save your project.
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Fig. 4.15: Export the project

Exercises

1.	 Prepare a narrative on the following topics:
	 a.	 A story you heard from your grandparents or parents
	 b.	 Mimicry of different cartoons
	 c.	 Collection of animal sounds
2. Prepare a video on the following topics:

a.	 A tree speaking to our citizens to safeguard its life
b.	 Different sources of water like river, sea, lake, 

groundwater, etc., speaking to each other on how 
various pollutants affect them.

c.	 Advertisement for implementing rainwater 
harvesting at home and school
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3. Test yourself
a. Match the following 

Audacity Recording Device

Smart Phone Audio Tool

Open Shot File Format

.osp Video Editor

.aup Audacity

b. Identify whether the following statements are True  
or False

  i.	.MP3 is the format in which video files can be saved. 
� (T/F)

 ii.	Blender is a video editing software.� (T/F)
iii.	Audacity is a free and open source digital audio 

editor. � (T/F)
iv.	 Open Shot is a software used for audio editing.
� (T/F)
 v.	Music files can be imported in Audacity to prepare 

audio resource. � (T/F)
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Chapter 
5

During their recent school trip, Samayra and Shirom 
got the chance to explore the historical places of Delhi, 
the capital of India. Few of their classmates were not 
able to join them.

Samayra: I wish all our friends were here with us. They 
not only missed the fun but also the knowledge about 
our rich heritage.

Shirom: It does not matter. Let us do something so that 
they don’t miss out on the learning.

Samayra: That would be nice. But how can we do it?

Shirom: Let us compile our experiences, highlighting 
the captured moments of the trip in a report.

Samayra: But this report will not give our friends the 
real picture of our experience and our interaction with 
the guide, etc.

Shirom: True. Then let's make a presentation.

Samayra: Shirom, what do you mean by a presentation?

Shirom: A presentation is used to present information 
using text, images, audio, video and animations. Do 
you know we can even add our narration to the slides ?

Samayra: Oh is it? This would be wonderful.

Presenting IdeasChapter
5
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Shirom: There are various ways to make effective 
presentations by including voice overs, videos and 
animations. It is going to be very interesting. Let us use 
Impress, a presentation tool from Libre Office Suite.

Shirom: Let us start. The first step is to open it by 
clicking on the Impress icon present on the desktop.

Shirom: By default a slide with Title Layout will appear, 
when we open a blank presentation as shown in Fig. 
5.1. We can choose the desired 
Layout from the various 
layouts, as shown in Fig. 5.2.
Samayra: Let us start.

Shirom: We can start with 
the first slide by giving a title: 
‘Historical Place of Delhi’ in the 
top placeholder and subtitle 
below it in the workspace 
area, as shown in Fig. 5.3.

Samayra: Shirom, can we add 
our names also?

Fig. 5.1: Impress interface

Fig. 5.2: Choosing the slide layout
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Shirom: Sure, let us do that.

Fig. 5.3: The title slide

Samayra: Can we add more content, such as text (as 
shown in Fig. 5.4), photographs or images, audio and 
videos, which we have collected during the visit.

Shirom: No. We will need more slides for that. Let us add 
more slides to our presentation.

Samaira: Great! Seems interesting. I hope our presentation 
will help them to get the  feel of the trip.

Fig. 5.4: Adding text content

Layout helps to 
decide the placement
of text or pictures on 
a slide.
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Samayra: Shirom, can we add a picture of the Red Fort?

Shirom: Yes, we can do that by using the Insert Menu 
(Refer Fig. 5.5).

Fig. 5.5: Inserting an image

Samayra: Once, we have inserted the image, can we also 
add some special effects to our images and text to make 
our presentation more attractive and grab attention of 
the audience.

Shirom: Yes, indeed! Let us select the text or object to be 
animated and add some custom animation to it, as 
shown in Fig. 5.6.

Fig 5.6 : Animating the image

For example, you may choose to apply various effects 
that may change the Font Size and apply special effects 
to the text, such as Blink and save that effect on the text.  
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Similarly, you can apply different effects in your slide to 
make your presentation interesting and attractive.

Samayra: Oh! Great but tell me how to check what we 
have done so far?

Shirom: For this we will preview our presentation using 
Slide show option, as shown in Fig. 5.7.  To do, press F5 
key or using the Slide Show menu. Let me now tell you 
one more interesting feature: Slide Transition which 
can be added from the view menu.

Samayra: I have taken a recording clip of the guide 
narrating the story. Also if we could insert the audio 
clip too! Moreover we have some video clips that also 
could be inserted in our presentation. It will make our 
presentation lively and more informative.

Shirom:  Yes, let us do it using the Audio or Video 
option of the Insert Menu, as shown in Fig. 5.8.

Samayra:  Tell me the steps how I should do it.

Fig. 5.7: Slide show
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Custom animation 
helps us to add 
emphasis on an 
object area on a 
screen.

Avoid adding too 
many animation 
effects on a slide as it 
reduces the focus on 
the main content.

Shirom: Now, if you wish, you can add more information 
in your presentation to enhance it with various colourful 
slides, animations, transitions effects and media and 
make it ready for the show. You can share your 
experiences of the trip with your classmates in the class 
with the help of projector and cherish the moments by 
viewing the slideshow. Once the show has started and 
in between if you would like to go to the next slide or 
previous one at a time, then Right-clicking anywhere on 
the screen brings up the floating menu that allows 
navigation of the slides as shown in Fig. 5.9.

Fig. 5.9: Navigating in slide show

Samayra: Shirom, can we view the sequential 
arrangement of  all the slides on a single screen?

Fig. 5.8: Adding sound
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Shirom: Yes, we can. The slide sorter view (as shown in 
Fig. 5.10) shows all the slides on the same screen which 
may help us re-arrange them if required.

Samayra: Now we are ready to share our presentation 
with all our classmates.

Shirom: No wait. To share the presentation we should 
convert it into Portable Document Format (PDF) (as 
shown in Fig. 5.11) which is an open standard file format 
for file viewing and sending it to someone.

Fig. 5.11: Exporting to PDF

Fig. 5.10: Slide sorter view

Chapter 5.indd   76 28-Feb-19   3:36:00 PM

Rationalised 2023-24



PRESENTING IDEAS 77

Samayra: It was so interesting to learn how to make a 
presentation and share it with our friends.

No effects or 
animations can be 
seen in PDF.

Exercises

1. Prepare a presentation on the following topics:
  (i) Your personal experience of meeting people in 

orphanage, old age home, etc.
 (ii) Experience of summer vacation
(iii) School's Annual day celebrations
(iv) Biography of a scientist or a historian

2. Test yourself
(a) Identify whether the following statements are True or 

False
   (i) We can make changes in the PDF version of any file.
 (T/F)
  (ii) We can insert video and audio clips in a presentation.
 (T/F)
 (iii) The number of slides that can be added in a 

presentation has a limit.  (T/F)
 (iv) Impress is a free and open source presentation tool.
 (T/F)
  (v) The background and design of the presentation 

cannot be changed once saved.  (T/F)
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Recall the instances in previous chapters when
•	 Muskan shared video of her experiment with her 

classmate using a messenger app.
•	 She created a blog and shared the images she 

clicked when she visited the state museum of 
Bhubaneswar.

•	 She thought of placing the song on web which she 
sang in a school function.

•	 She started speaking to Hasmukh on Skype 
instead of telephone.

•	 She shared the digital album of her birthday with 
Hasmukh through email.

•	 She decided to join an online course on puppetry 
during her summer vacation.

Reflect how all this was possible.

Internet is used to search and gather resources to 
enhance knowledge and to complete your projects. In 
earlier times, library was the most sought after place for 
gathering information from books and encyclopaedias. 
But nowadays Internet has made it possible to search 
and gather variety of multimedia resources for learning. 
Take example of a project on “Role of youth in the 
development of a nation”.

Chapter 
2

Chapter 
1

Getting Connected
InternetChapter

6
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You can get resources on the above topic from the 
Internet. These days, almost all information and services 
are available on the Internet. For logging on to the 
Internet, you just need an electronic device (preferably 
computer/laptop/smartphone/tablet) with an Internet 
connection. You can access a large number of resources 
and information  stored on the World Wide Web (WWW). 
In order to access the resources in WWW, we need a 
software called Web Browser. Web browsers are generally 
present in our computer system. A few popular web 
browsers	have	been	shown	in	Fig.	6.1	,	fill	in	the	blanks	
with any two other web browsers.

Fig. 6.1: Web browsers

When you click on the browser icon in your computer, 
the following window will be opened. On top of the 
browser window, there is an address bar as shown 
in Fig. 6.2.

Fig. 6.2: Layout of Mozilla Firefox browser

World Wide Web 
(WWW) is an 
information space on 
the Internet where 
documents and other 
resources are stored.

A Web browser 
is  a software for 
accessing  
information and 
resources on the 
World Wide Web.  
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The address bar let you type the address of the resource 
which you want to access on the web. Every resource 
is available in a web page on the web. Once you type 
the URL in the address bar, the webpage will open from 
where you can access the resources.

A website contains many webpages. The first page that 
you see, when you open a website is the Home Page.

Activity 1
•	 Open the website by typing the address 

creativecommons.org in the address bar.
•	 Keeping in mind the title “Role of youth in the 

development of a nation”, explore resources related to 
your project. 

While exploring the website, you might have noticed 
that when you hover the mouse over certain text/
images, the cursor changes to  <insert hand symbol>.
This signifies that the text/image is a link to another 
webpage or resource which is known as Hyperlink.

Activity 2 
•	 List and click on any of the three hyperlinks in the 

website: creativecommons.org 
___________________________________________________
___________________________________________________
___________________________________________________

Suppose you are not aware of the URL of the website 
from where you can access the resources or if you 
want to search the web for finding more information/
resources, you can take help of the Search Engine.

Following are a few popular search engines:

Name Address

Google google.com

Bing bing.com

A Webpage is a
collection of
information in the 
form of multimedia
resources.
The Website is a
collection of 
Webpages.

A Search Engine is a 
tool that allows  
to search for 
information on web.
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Yahoo yahoo.com

Ask ask.com

DuckDuck duckduckgo.com
Table 6.1: Popular search engines

To search information/resources using a search engine 
you need to use keyword in the Search Box as shown in 
Fig. 6.3.

While using search engines, a good plan can save 
your time. Before searching ask yourself the following 
questions like:

•	 What type of information am I seeking (ideas, 
facts, opinions, options)?

•	 What form of information am I seeking (text, 
images, videos)? 

According to the above questions, select the keywords. 
Use words related to the type of information you seek. 

Fig. 6.3: Search Engine
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Word or phrase 
entered in the search 
box helps the search 
engines to list those 
webpages which 
contain that word 
or phrase. Now for 
your	specific	search	
the entered word or 
phrase becomes 
the keyword.

Select precise words and avoid common words, such as 
the, of, apply etc.

Did you get what you were looking for, by using the 
keyword which you had listed above? If not, reframe the 
keyword by answering the following questions:

•	 What exactly are you looking for? 
•	 What words will describe your search best? 
•	 What if you want only images related to your 

keyword? 

If you are sure about the type of multimedia resource 
you are looking for, then the search engine helps you 
filter	the	resources	based	on	your	requirement.	 If	you	
notice in the result page, by default the results are 
displayed under the heading ‘All’ but there are other 
headings that help you to categorise the search result 
on the result page as shown below.

Fig. 6.4: Heading in search engine

In order to get a result page containing only images, you 
can click on the Images heading or if you are looking for 
only videos, you can click on the Videos heading. This 
helps to categorise the search based on  particular type 
of resources.

Activity 3

As per the project titled “Role of youth in the development 
of a nation”, you need to get the information and 
resources. So you can use the keyword “Role of youth 
in the development of a nation” in the search engine to 
search for resources. Explore the result page and answer 
the following questions:
•	 What types of multimedia resources you could see?
•	 Did	you	find	any	hyperlinks	in	the	result	page?
•	 How can you get a different result page for the same 

keyword?  
•	 Were	you	able	to	find	a	result	page	for	your	search	

containing only images?
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Sometimes while accessing multimedia resources you 
might come across a prompt asking you to install a 
‘plug‑in’ by clicking on the link mentioned in the prompt. 
Go ahead and click on the link to install plug‑in and 
access the resources.

Note: Whenever you use the resources taken from the 
web, you should cite reference to the source from where 
you have taken it. It ensures that you are giving credit 
to the owner who actually created it.

To plan further for your event and to collect resources 
according to your requirement, you need to identify the 
keywords for the programme items. Fill in the graphic 
organiser depicted in Fig. 6.5 with appropriate keywords 
for the listed programme items and write programme 
items of your choice along with keywords for searching 
resources for these programme items using the 
search engine.

Activity 4
Use the keywords written in the above graphic                  
organiser to search only for images in search engine.

Fig. 6.5: Identifying keywords

Now you must be comfortable using simple keywords 
in search engines to collect resources for your event. 
But if you want to search information/resources very 
specific	to	your	requirement,	then	you	can	do	advanced	
search using search operators like AND, OR, “ ”, … as 

A plug‑in is a 
software which 
provides additional 
functionality to the 
browser allowing it to 
display the content.
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mentioned in the table given below. These operators 
help the search engine to narrow down the focus of 
search (Refer Table 6.2).

The process of saving 
the URL of the 
webpage for future 
reference is known as 
Bookmarking.

Table 6.2: Search operators

Operator Example Purpose

AND youth AND nation The result shown will include pages 
having all the keywords.

OR youth OR nation The result shown will include pages 
having at least one of the keywords.

“ ” “Role of youth in the 
development of nation”

The result shown will include pages 
having the entire keywords.

… “Role of youth” 1990…2018 The result shown will include pages 
having	the	specified	number	range.

While searching for resources, you might come across 
certain web pages which you wish to refer to later. You 
can take a print out of the web page but that would lead 
to paper wastage. So instead you can bookmark the web 
page  to enable quick access to the webpage in future. 
To bookmark the webpage or website, click on the 
Bookmark icon (which looks like a star) in the address 
bar as shown in Fig. 6.6.

Fig. 6.6: Bookmarking
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Evaluation of the Resources
You must have gathered lot of information from the 
Internet for your event by now. But you should remember 
that all the information available on the Internet cannot 
be guaranteed for quality or accuracy. So it is important 
to evaluate the resource or information. Keep in mind 
that anyone can publish anything they wish on the Web. 
It is often difficult to determine the ownership of the 
Web resources. So it is your responsibility to evaluate 
the resources effectively based on the following criteria:

•	 Who has made the website and how to contact the 
website owner?

•	 What is the website about? Is it commercial, 
educational, etc.?

•	 Is the website for teachers or for students or for 
both?

•	 Is the information reliable on the website? Always 
cross check the given information from other 
websites and other authentic sources like books, 
experts, etc.

•	 Check whether the website offers free information 
or paid information?

After gathering resources, it is time to make use of them 
for your event. You might have downloaded text, images, 
audio, videos related to your programme items. Use 
your creativity by customising the resources gathered 
from the web using the ICT tools. You should identify 
the right ICT tools to prepare the programme using the 
resources you have gathered.

Fig. 6.7: ICT tools in identification
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Safe Practices while Searching
•	 While searching information for your event on the 

internet, few questions might have struck your mind like
•	 Is the Internet safe for me?
•	 How can I differentiate between a real and a fake 

website? 
•	 What do I have to do to be a safe user of Internet?

All computer users ask these questions to themselves 
every day. The Internet offers so many opportunities 
to explore. But it is important to keep yourself safe 
and secure, so that you can make the most of it. The 
tips given below will help you to search the web safely  
and securely.

•	 It is always advisable to access resources from 
websites which have “https” in the URL as it indicates 
that it is a secured website.

•	 Make sure the “Safe Search” Setting of the web 
browser is ON.

•	 Think twice before clicking the links as it might lead 
to websites not appropriate for your age.

•	 Most of the interaction with the Web is through the 
browser. So the choice of the Web browser should be 
of utmost priority.

Now you are ready to present a great show with a variety 
of multimedia resources created by you for the event. 
Ensure the required hardware resources like projector, 
speaker, etc., are available to use these multimedia 
resources during the event. Such remarkable effort will 
lead to an exceptional result but it is advisable to take 
feedback and remedial measures to ensure an effective 
event execution.

You have taken the first step of showcasing a 
remarkable event that was appreciated by the audience 
who were present there. With the appreciations you 
received, you are motivated to share your experience, 
the photographs and videos taken during the event to 
your friends.
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Activity 5 
Can you think of various ways through which you can 
share your experience with your friends?
_______________________________________________________ 
_______________________________________________________ 
_______________________________________________________

You have effectively acquired the skills of searching 
information using a search engine. Besides searching 
you can also communicate and share information with 
the people using Internet. There are many ways of 
communicating and sharing information on the Internet, 
one of them is Electronic mail (Email). Emails can be sent 
from anywhere, anytime through the Internet‑enabled 
devices, such as like PC, laptop, smartphone, etc. To 
send and receive emails you need to create an account 
with any of the email service providers some of which 
are mentioned in Table 6.3.

Table 6.3: Email service providers

Email Service Providers URL

Gmail gmail.com

Yahoo mail login.yahoo.com

mail mail.com

Outlook outlook.com

To create an email account on the email service provider 
you need to follow the below given steps. 

•	 Type the URL of any of the email service provider 
in the browser and click Create account/Sign Up/
Register.

•	 Specify a unique username. (The email service  
provider prompts in case the username is already  
chosen).

•	 Choose a strong password consisting of uppercase, 
lowercase letters, numbers and special symbol(s). 
Passwords are case sensitive.
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•	 Fill in the mandatory personal information like 
first name, last name, date of birth, gender, etc.

•	 Carefully go through the Terms and Conditions 
before clicking on Agree button.

The account created will be in the format username@
email-service-provider like shiksha@gmail.com or 
shiksha@yahoo.co.in

Checklist for a strong password
Did you
•	 use combinations of letters (uppercase and lowercase), 

numbers and symbols?
•	 use at least six to eight characters?
•	 set a unique password for each of your important 

accounts?
Example: 13Hlt@8L
Note: Don't forget to change password frequently.

After creating an email ID you can now use it to share 
experiencs and resources that you have created for the 
event with your friends who are staying in different 
cities. To do so, you need to do the following as shown 
in Fig. 6.8:

•	 Login to your account
•	 Click Compose/Write
•	 Enter your friend’s email ID in “To” box
•	 Write the subject of your email
•	 Write the content of the message
•	 Attach your document(s) if needed as shown in 

Fig. 6.9.
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Components of email message
To – Mail ID of the person to whom we want to send the 
mail.
Subject – It is a description of the topic of the message
Cc (Carbon copy) – Mail ID of the person to whom we want 
to send the copy of the mail
Bcc (Blind Carbon Copy) – Mail ID of the person to whom 
we want to send the copy of the mail but these mail IDs 
will not be visible in the email.
   – Attachment icon to insert documents in the mail.
Send – A button which sends the mail when clicked.

Fig. 6.8: Compose/write an email
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Fig. 6.9: Attaching a document

You have successfully sent the mail to your friends 
about your event experience with some documents
as attachments. 

One of your friends, Taleem who received your email 
also shared the script written by him for a similar event 
that he has planned and is asking for your opinion. You 
can see his mail in the inbox. You can click on the email 
to read its content as shown in Fig. 6.10.

Fig. 6.10: Inbox
If there is any attachment in the mail then you need to 
be careful and question yourself before downloading the 
attachment as there is a chance that the attachment is 
infected with virus.

Attaching a 
document to your 
email is also known 
as uploading. 

Inbox is an                        
electronic folder in 
the email account 
where all the received 
mails are stored.
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A virus is a harmful 
program which 
when enters the                        
computer, affects 
the performance of 
the computer and              
destroys its data.

Anti‑virus 
programmes are used 
to detect and destroy 
computer virus.
Examples of Anti‑
virus programs are 
Norton, Kaspersky, 
Mcafee, etc.

Transferring 
documents/files	
from Internet to the 
computer is called 
downloading.

Exercises

Checklist for Downloading
Always be alert. An attachment can be a malware, such 
as virus which are harmful to the computer and its user. 
So check for the following before proceeding.

•	 Is it from a trusted source?
•	 Is it in a known format?
•	 Did you perform anti‑virus scan?

Once you get answers for the above questions positively, 
and then follow the steps shown in the Fig. 6.11.

Fig. 6.11: Inbox

We learnt how to access the Internet and communicate 
using email. You must have also heard about the various 
security concerns in this Internet‑based world known 
as cyber world. The threats associated with technology 
are largely due to inappropriate use of technology and 
to expect that all the users will exhibit ideal behaviour 
is unreal. Hence, it becomes our primary responsibility 
to exercise caution and at the same time behave 
responsibly like we do in the real world by setting an 
example for others. We will learn about safe internet 
practices in Chapter 7.

1. Open the websites given below and identify the purpose 
for which they can be accessed.

Website Address Purpose
mygov.in
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swayam.gov.in
ndl.iitkgp.ac.in
farmer.gov.in
ors.gov.in

2. 	Using a search engine try to find the website address of 
the following and enter it in the Table given below:
•	 Indian railways website
•	 Tourism website
•	 NCERT website

Searched for Website Address
Indian railways
Delhi tourism
NCERT 

3. 	Identify keywords and the type of resources required  
and create multimedia resources (presentation 
video) on the following topics:
•	 Technology — the latest trends
•	 Plastic — A friendly foe

4.	 Identify the invalid email ID and specify the reason.
     i.  Aayush. gmail.com
    ii.  School_yahoo.com
   iii.  Suhana@rediffmail.com
5. 	Download your syllabus from the NCERT website. Save 

it on your device and email it to your friends. Also, send 
the same syllabus file to your parents.

6.	 My teacher has asked me to write an essay on ‘Green 
Revolution’, and also I need to prepare a list of ‘Keywords’ 
for searching information on the topic. I have prepared 
a list, help me to identify which of the key words are not 
much useful among the following:

•	 Agriculture
•	 Norman Borlaug
•	 M.S. Swaminathan 
•	 Wheat farming
•	 Dairy farming
•	 Fish farming
•	 Crop yield
•	 Genetically modified crops
•	 Biotechnology
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Since childhood our parents and elders have been 
guiding and suggesting us to take care of our eating 
habits, practice hygiene, be wary of strangers, 
communicate effectively and so on to ensure that we 
develop into confident, strong and positive individuals 
who are able to cope up with the competition and 
complexities of the real world. With the advent of 

Fig. 7.1: Cyber World

Digital footprint is 
the information 
about a particular 
person that exists 
on the Internet as a 
result of their online 
activity even after its 
deletion.

Safety and Security
in the Cyber WorldChapter

7
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Internet, all of us have also become a part of a cyber 
world wherein we share and access resources, connect 
and interact with many people. Just like real world we 
need to be cautious and alert while working in this cyber 
world as well.

Email is used to send and receive information and 
messages but one needs to be careful while using email 
as many a times one may find emails which are from 
unknown source saying that you are a lucky winner 
or asking you to provide personal information. These 
mails will tempt you to follow the instructions written 
in the contents of the mail. Such emails are called spam 
mails and are sent with malicious intent to get you  
into trouble.

Let’s look at some of the examples of spam mails.

Fig. 7.2 : Sample email-1
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In the Fig. 7.2 given above, you can find some common 
signals that you would usually find in a spam email.

Assume there is another email in your inbox asking you 
to download a popular game for free which otherwise 
costs 3̀,500/- as shown in Fig. 7.3.

Activity 1
In the Fig. 7.3 given above, which one of the following 
proves that it is a fake email? Choose the option from 
the list given below.
•	 The offer is valid only for the next 48 hours.
•	 Incorrect spelling of FIFA in the email ID in ‘From’ 

Box.
•	 The cost of the game mentioned in the mail is not 

correct.

Assume there is another email in your inbox which 
contains links asking you to provide account details 
for verification purpose. If you click on such links or 
download any attachments, they may lead you to a 
phishing website or install harmful malware (malicious 
software) on your device, as shown in Fig. 7.4.

Fig. 7.3: Sample email‑2
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Phishing is an 
attempt to obtain 
sensitive information 
such as username, 
password and credit 
card details etc. for 
malicious reasons, 
by  osing as a 
trustworthy source in 
email.

Fig. 7.4: Sample email-3

Activity 2
Identify the URL(s) which are indicative of a fake 
website?

http://www.uiidai.gov.in/
http://www.incometakindiaefilling.gov.in/
https://onlinesbi.com

The above scenarios are examples of fraudulent emails. 
You need to be cautious before proceeding with any of 
the instructions given in the email.
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Protection from email fraud
•	 Do not reply to emails from unknown senders even if 

it looks like a genuine email.
•	 Do not provide personal information like name, date 

of birth, school name, address, parent’s names or any 
other information. 

•	 Do not fall for lucrative offers/discounts as they might 
be coming from unknown source and it may not be 
reliable. Ignore/delete those mails. 

•	 Do not open attachments or click on links from 
unknown senders, since they may contain 
malicious files that might affect your device. Only 
click the links and downloads from websites that 
you trust.

•	 Beware of phishing websites — check the URL to 
confirm if the website is secure.

•	 Do not forward spam or suspicious emails to others.
•	 Do not send excessive forwards as it might be 

distracting to the receiver.

You have learnt how to use email for sharing information 
and what safety precautions to be taken while using 
email. Through email you can reach out to people only 
if you have their email ID.

Activity 3
Can you think of ways to share your event with a larger 
audience?

The Internet allows us to exchange and share   
information, connect with people online across the 
world and create our own networks through social  
networking sites.

In order to create an account on a social networking site 
you need to use your email ID as username.
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Activity 4
Search and write the names of any three social
networking sites

1. ____________________________________________________
2. ____________________________________________________
3. ____________________________________________________

Though social networking is very interesting as it gives 
you a chance to get connected with people around 
the world you should make sure you follow all safety 
precautions while using social networking as it is 
extremely difficult to judge and recognise a person 
here. We only know them by the identity they choose to 
present.

While creating an account on social networking sites, 
you need to take care of the following:

• Avoid revealing too much of your personal 
information like your age, address, contact details, 
school name, etc., as this can lead to identity theft

• Do your privacy settings very carefully on social 
networking sites

Anyone on social networking, needs to take care of the 
following:

• Never reveal your password to anyone other than 
your parent or guardian

• Change your password frequently
• Communicate and collaborate only with people 

known to you
• Do not post anything which hurts others feelings
• Always be careful while posting photographs, 

videos and any other sensitive information on 
social networking sites as they leave digital 
footprints which stay online forever

• Do not post your friends’ information on social 
networking sites, which may possibly put them at 
risk. Protect your friends’ privacy by not posting 
the group photos, school names, locations, 
age, etc.

Social networking 
site is an online 
platform to connect 
and network with 
people around the 
world. One can also 
send and exchange 
messages and share 
photos, videos, 
etc., through such 
platforms.

Check your privacy 
settings Make sure 
you know what 
information is being 
shared publicly.
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•	 Avoid posting your plans and activities on social 
networking sites.

•	 Do not create fake profiles for yourself on any 
social networking sites.

•	 If you suspect that your social networking account 
details have been compromised or stolen, report 
immediately to the support team of networking 
site.

•	 Do not forward anything that you read on social    
media without verifying it from a trusted source. 

•	 Always avoid opening links and attachment 
through social networking sites.

•	 Never leave your account unattended after login 
and log out immediately when you are not using it.

The photographs and the resources you share might 
get you positive feedback and comments. However, at 
times you might face instances of cyber bullying. Cyber 
bullying includes:

•	 Nasty comments on your posts or posts about you.
•	 Someone creating a fake profile in your name and 

trying to defame you. 
•	 Threatening or abusive messages online or on the 

mobile phone.
•	 Being excluded from online groups and forums.
•	 Embarrasing photographs put online without 

your permission.
•	 Rumors and lies about you on a site.
•	 Stealing your account password and sending 

unwanted/inappropriate messages from your 
account.

•	 Offensive chat.
•	 Fake online profiles created with an intent to 

defame you. 

If you become a Victim of Cyberbullying, do the following:

•	 Do not Respond
If someone is cyber bullying you, do not respond or 
retaliate by doing the same thing back. Responding  or 
retaliating to cyber bullying may make matters worse or 
even get you into trouble. 

Identity theft is 
the deliberate use 
of someone else’s 
identity to obtain 
credit and benefits 
in the name of 
another person or 
to sometimes even 
defame that person. 
It  is one of the 
most common cyber 
crimes. It poses a 
severe threat to a 
person’s reputation, 
unlike the real world 
the cyber world has 
a far larger reach, 
hence it is essential 
that we exercise the 
following precautions 
to prevent any such 
incident:
•	 Never share 

password with 
anyone

•	 Keep strong 
passwords

•	 Do not divulge 
your personal 
information

Cyber bullying 
includes sending, 
posting or sharing 
negative, harmful, 
false or mean 
information and 
content about 
someone. It is a 
serious offence which 
is punishable under 
Cyber Law.
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•	Screenshot
Take a screenshot of anything that you think 
could be cyber bullying and keep a record  
of it.

•	Block and Report
Most online platforms have this feature, if 
someone  bothers you, make sure you block 
and report the offender to the social media 
platform.

•	Talk About It
Cyber bullying may affect you in many 
different ways. Dont feel that you are alone. 
Let your parents and teachers know what is 
going on. Never keep it to yourself.

•	 Be Private
Keep your social media privacy settings high and do not 
connect with anybody who you do not know offline. You 
would not talk to random people on the street, so why 
do it online?

•	 Be Aware
Remain updated with all the preventive and security 
measures in the cyber world. 

Fig. 7.6: Talk about it

Fig. 7.5: Block

Exercises

1.	 Fill in the blanks
a.	 ______________ often directs users to a fake website 

whose look and feel are almost identical to the 
actual website.
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b.	 Undesired or illegal email messages are often known 
     as ______________.
c.	 The protection of internet connected systems 

including hardware, software and data from cyber 
     attacks is termed as _____________________.
d.	 A __________________ is a form of malicious software 

program which can corrupt or destroy systems  
or data.

2.	Match the following
	 1	 Malware	 a.  Email
	 2	 Spamming 	 b.  Virus
	 3	 Cyber law	 c.  Stealing data
	 4	 Phishing 	 d.  Cyber crime

3. Identity whether the following statements are True 
or False
a.	 Hacking is a cybercrime.
b.	 Phishing is a type of attack which is capable of 

stealing your password or credit card number.
c.	 Social networking sites are used to share passwords 

and other secret information.
d.	 When you are receiving harmful messages on your 

computer, you may block or delete them.
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Jason is the sports captain of his school. He was thrilled 
to receive the Chief Minister’s scholarship for his 
outstanding performance in sports. But his scholarship 
amount has to be credited to his bank account and Jason 
does not have a savings bank account. He does not even 
know how to open a bank account. So he approaches 
a bank in his locality and the bank employee at the 
helpdesk gives him instructions to complete the task as 
given below.

1.	 Take the account opening form from the counter. 
2.	 Fill the details in the form carefully.
3.	 Put your signature at the designated place on the 

form.
4.	 Attach a copy of the photo identity card.
5.	 Submit the form at the counter with a minimum 

deposit.

After understanding the process to open a bank account, 
Jason gets on to work. When he went to complete the 
final step, which was to submit the form, the clerk 
informed him that his account could not be opened. 
What would have gone wrong? What reasons can you 
think of?
_____________________________  
_____________________________                   
_____________________________    

Fun with Logic
Chapter

8
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Once again Jason checked the steps to open the bank 
account. It was then that he realized that he had missed 
Step no 3 which was to put signature at the designated 
place on the form and that was why the task of opening 
the bank account could not be completed. Thereafter, 
he put his signature and submitted his form again. His 
account was finally successfully opened.

Have you ever faced such a problem while completing 
a particular task? What happens if you do not follow 
the correct sequence of steps? Will you get the desired 
result?

Activity 1
On the eve of the Independence day, you want to listen to 
the Prime Minister’s address on the radio. Write the steps 
to complete the task.
_______________________________________________________   
_______________________________________________________
_______________________________________________________
_______________________________________________________
_______________________________________________________
_______________________________________________________

Now ask your friend to follow the steps written by you. 
Are you able to tune in to listen to the Prime Minister’s 
address? What happens if you interchange any of the 
steps? Are you still able to get the desired result?  

By now, you must have understood the importance of 
instructions and the sequence of instructions to 
complete a particular task. To accomplish a task and 
to get the desired output, you have to mention each 
instruction clearly, sequentially and logically, as 
shown in Fig. 8.1. So to achieve a task, the steps are 
listed below.

1.	 Clearly identify the output that you want. 
2.	 Analyse the instructions required to find a solution 

to get the desired output.
3.	 Finalise and give instructions in the proper 

sequence.
4.	 Verify whether the output produced is as desired 

by you in Step 1.
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Identify the Output •	 Do you clearly know what output has to be produced?

Analyse

•	 Do you have multiple solutions?
•	 Which is the best possible option?
•	 Have you identified the correct sequence of 

instructions?

Finalise  
Instructions •	 Give the instructions in logical sequence.

Verify the Output •	 Is the output same as you had identified in Step 1?

Fig. 8.1: Steps to complete a task

Consider a situation where the Twirly cat has lost the 
way to her house as shown in Fig. 8.2.

Fig. 8.2: Twirly cat finding its way

What instructions would you give her to help her reach 
the house? Write them in the space provided below:
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Scratch is a free 
programming 
language developed 
by MIT in the 
 year 2005. 

Step 1: Move forward by 10 steps.
Step 2: Turn right by 90 degrees

Have you given the right instructions? Will Twirly cat 
reach its home? Can you check the given instructions 
using any software application or tool? Yes, you can 
do so by using the Scratch application. Using this 
application you can create your own stories, games and 
various other animations using simple drag and drop 
instructions.

Animations in Scratch can be created offline as well as 
online mode. As it is an open source software you can 
download it from https://scratch.mit.edu , install it on 
your computer and then use it. You can also create and 
share your animations online using the above URL.

On opening Scratch, you see the interface as shown in 
Fig. 8.3. Each object on the scratch window is called a 
sprite. This object can be any person, an animal, an 
automobile, a building or even text.

After learning about the Scratch interface let us now 
verify the steps that would take out Twirly cat home. In 

Fig. 8.3: Scratch Interface
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the Scratch window, our Twirly cat will be called a cat 
sprite. To make the sprite move on a specific path, you 
have to choose the appropriate instruction block and 
drag it to the script area. Make sure you choose the 
instructions in a logical sequence. When the script is 
complete, you need to execute it to see the output on 
the stage (Refer Fig. 8.4).
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Fig. 8.4: Path traversed by cat sprite

Activity 2
Build a script to make the cat sprite follow the paths 
drawn below.

               

   

         

Chapter 8.indd   107 7/22/2020   12:36:52 PM

Rationalised 2023-24



ICT Textbook — Class IX108

Scratch is not just about static shapes. You can 
even create an animated story using various  
characters (sprites), instructions and tools using 
Scratch. 

Have you ever thought that instructions have to 
be given in a logical sequence to communicate your 
ideas too? In the previous chapters, you have learnt to 
communicate your ideas through text, images, video 
and audio using various tools and applications. The 
audio and video tools helped you to communicate 
with realistic images and videos. But what if you had 
an imaginary concept or story to communicate with 
your friends? Such a story may not have any realistic 
character. For example, a fairy tale or a story of two 
animals going on a space voyage or two fishes talking 
in water. Can that be done using any text editing, 
image editing or presentation tool?

Let us create a story where the underwater animals  
are talking about water pollution. Our imaginary 
characters will be a star fish named Twinkle, an octopus 
named Octi, a whale named Blue and a fish named Laali.  
In our story we need the following objects:

•	 Underwater background
•	 Octi, an octopus
•	 Twinkle, a starfish
•	 Blue, a whale
•	 Laali, a fish
•	 Text in the form of dialogues or messages
•	 Sound of cough
•	 Sound of water drops and ripples
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Script for the story to be created

(Underwater backdrop with water, water plants and water animals)
A red fish glides from right side, comes towards the centre and then slowly 
moves out from left side)

(sound of water drops and ripples will be heard at frequent intervals 
throughout the movie)

Twinkle : Cough… Cough (sound of male cough)
Octi (glides from left side) : Hey Octi … Are you OK? What happened? (moves  
a bit)
Twinkle: Oh Octi…Cough Cough…This dirty water will kill me. (sound of male 
cough)
Octi : OHH!!
Blue: (glides from right side) OH GODD!! My eyes are burning.
Octi : These humans , they pollute our water and we suffer. (sound of male 
cough)
Blue: What’s wrong with the water today?
Blue: We all will die one day. (Blue whale glides down)
Octi: Let’s all request them. (Twinkle and Octi move towards their left)
Message pops up on the screen 
“ Stop Water Pollution”

So in your story, you will need an underwater background 
with four sprites that you can add from the variety of 
sprites provided by Scratch. When you open Scratch, 
the default cat sprite will be present in the centre of 
the stage. All sprites that you will further add will also 
appear on the stage, as shown in Fig. 8.5.
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You can select 
multiple sprites from 
the Sprite Library 
by keeping the Shift 
key pressed while 
selecting the sprites.

By default, the cat sprite is displayed in all Scratch 
projects but in your story you do not need it. So it has 
to be deleted, as shown in Fig. 8.6.

Fig. 8.5: Adding a sprite
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Fig. 8.6: Deleting a sprite

You want to give a message at the end. For this purpose 
you need to add a text sprite also (Refer Fig. 8.7).
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You may require to move a sprite from one position 
to another. Scratch helps you to specify position of a 
particular character using coordinates. The stage on 
which the characters are placed is just like a coordinate 
plane with x and y coordinates as shown in Fig. 8.8.

Fig. 8.8: Coordinates of X-Y plane (stage)

Fig. 8.7: Adding a text sprite

Chapter 8.indd   112 7/22/2020   12:37:02 PM

Rationalised 2023-24



Fun with Logic 113

According to this plane any character placed on the 
centre of the stage has the X any Y coordinates as 
(0,0). The maximum and minimum values for any of 
the coordinates can be 240 and –180, respectively. As 
you move your mouse pointer on the stage, the x and y 
coordinates displayed on the right bottom  of the stage 
keep on changing.

  
Fig. 8.9: Coordinates of mouse pointer

You might need to specify these coordinates while giving 
instructions for movement of the selected sprite from 
one position to another.  

As per your story six sprites (4 characters plus 1 text 
sprites) have been added to the project. But the stage is 
having a white backdrop while your script requires a 
backdrop that depicts the underwater world. (Refer  
Fig. 8.10).
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So now you are in 
the water world. 
Next, you might 
need to select 
different forms 
of the added 
sprites. Each 
form is known 
as a costume. 
You can add as 
many costumes as 
required by you 
for the story (Refer 
Fig. 8.11).

Fig 8.10: Adding a backdrop to animation
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After the costumes for each sprite are added, add the                    
sounds required in your project for each sprite, as                                        
shown in Fig. 8.12.

Fig. 8.11: Adding costumes to a sprite
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After adding sprites, costumes and sounds, our next 
step is to build an animated story using these sprites, 
their costumes and sound effects. This process involves 
giving instructions in a logical sequence and the set of 
instructions for each sprite is called a script. The script 
will contain instructions for each and every action 
for that particular sprite. These actions may include 
movement, sound, change of costume, etc., as shown 
in Table 8.1. Each instruction is dragged from the 
Scripts tab to the script area. You can drag as many 

Fig. 8.12: Adding sound

Chapter 8.indd   116 7/22/2020   12:37:15 PM

Rationalised 2023-24



Fun with Logic 117

Table. 8.1: Types of instructions

Some commonly used script categories and instructions
Category Instructions Explanation

Motion Move <n> steps
Turn  <n> degrees
Glide <n1> secs to 
x:<xn> and y: <yn>

Move the sprite by n number of steps 
Turn right by n degrees
Move while gliding in n1 seconds to xn and yn 
coordinates

Looks Hide
Show
Say <text>
Say <text> for <n> 
secs
Switch costume to <cst>

Hide the sprite
Show the sprite
Display text in speech bubble 
Display text in speech bubble for n seconds
Change the costume of the sprite to any of the 
added costumes (cst)

Sound Play sound <audio>
Play sound <audio> 
until done
Stop all sounds

Play audio and move to next instruction block
Play audio till it is complete and then move to 
next block
Stop all sounds

Events When  clicked Run the script when green flag is clicked

Control Wait <n> secs Wait for n seconds, then move to next block of 
instruction

instructions as you want and add them to the script 
stack in the script area on the right side of the Scratch 
window. The added instructions will be executed in the 
same sequence as you have stacked them. Some of the 
commonly used instructions are listed below along with 
their explanations.

After learning about some of the instructions that can 
be given to the sprites, you can now start forming the 
scripts for each sprite, as shown in Figs. 8.13 and Fig. 8.14.
Once you have formed scripts for your sprite, you would 
like to see the output (Refer Fig. 8.15).
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Fig. 8.13: Forming a script for Starfish Sprite
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Fig. 8.14: Scripts for all characters of the story
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Activity 4

Create an animation in which your name appears in an 
animated manner. (Hint: Use letter sprites) 

After completing the activity, answer the following 
questions:

1.	 How many sprites did you add? 

2.	 Did you add costume for any of the sprite?

3.	 Did you add sound? 

4.	 Did you run the script in full screen mode?

Fig. 8.15: Playing the animation

Exercises

Do it Yourself

1.	Use Scratch to draw the following alphabets:
	 A, E, F, H, M, W, Y, Z
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Exercises

2.	Draw the following figures in Scratch

     

    

3.	Create an animated story using Scratch for the 
following:
a.	 A jungle where a lioness is giving safety tips to her 

cubs. 
b.	 A spacecraft moving in space.
c.	 A dance performance on stage by a fairy.

4.	Identify True and False Statements from the  
following:
a.	 You can create animated stories with imaginary 

characters by Scratch.�  (T/F)
b.	 Animations in Scratch can be created online only. 

� (T/F)
c.	 By using Scratch we can create static shapes as 

well as animated stories using various sprites, 
instructions and tools. � (T/F)

d.	 Each object on the Scratch window is called a 
sprite. � (T/F)

e.	 Scratch has an inbuilt library of sprites.�  (T/F)
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